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Warranty

 

Maxtor’s warranty obligations are limited to the terms set forth: Maxtor warrants 
only to the original consumer purchaser that new Maxtor products will be free 
from defects in material and workmanship for 1 year from the date of original 
purchase.

For a replacement product, the warranty on the replacement device is the 
remainder of the warranty on the original device or 90 days, whichever is longer. If 
you discover a defect, Maxtor will, at its option, repair or replace the product at no 
charge to you, provided you return it during the warranty period, with 
transportation charges prepaid, to Maxtor in Ireland, Singapore or the USA.

Products must be properly packaged in Maxtor packaging or Maxtor approved 
packaging to obtain warranty service. Before returning a Maxtor product, please 
contact Maxtor at: +353 1 204 1111 (in Europe) or 1-800-2MAXTOR (in U.S.) to 
obtain a Return Material Authorization (RMA) number. A copy of the receipt or a bill 
of sale bearing the appropriate Maxtor serial number and model number may be 
required for warranty service. The warranty applies only to the Maxtor products 
that can be identified by the Maxtor trademark, trade name, serial number or logo 
affixed to them. Maxtor does not warrant any product that is not manufactured by, 
for or with permission from Maxtor.

This warranty is not applicable to: Abnormal wear and tear; Abuse, unreasonable 
use, mistreatment, or neglect; Damage caused during installation of the Product; 
Damage caused by the equipment or system with which the product is used; 
Damage caused by modification or repair not made or authorized by Maxtor; 
Product whose Maxtor Serial Number has been removed or defaced; Damage 
caused by liquids in the product case; Damage to the products’ interface or power 
connectors; Damage caused by use of non-Maxtor packaging; Damage caused by 
improper or improperly used packaging; Products that are determined to be stolen.

THIS WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND 
IN LIEU OF ALL OTHERS, WHETHER ORAL OR WRITTEN, EXPRESSED OR 
IMPLIED. MAXTOR SPECIFICALLY DISCLAIMS ANY AND ALL IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND 
AGAINST INFRINGEMENT.

Additionally, Maxtor does not warrant that the installation software for Macintosh 
OS and Windows OS will meet your requirements nor the performance or results 
that the operation of the program will be uninterrupted or error free. No Maxtor 
dealer, agent or employee is authorized to make any modification, extension or 
addition to this warranty.

MAXTOR IS NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF 
WARRANTY, OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, 
DAMAGE OR REPLACEMENT OF EQUIPMENT AND PROPERTY, AND ANY 
COSTS OF RECOVERING, PROGRAMMING OR REPRODUCING ANY 
PROGRAM OR DATA STORED IN OR USED WITH MAXTOR DISK DRIVES OR 
MAXTOR PRODUCTS CONTAINING MAXTOR DISK DRIVES or any software 
product distributed therewith.

Some states/jurisdictions do not allow the exclusion or limitation of incidental 
or consequential damages or exclusions of implied warranties, so the above 
limitations or exclusions may not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights that vary from 
jurisdiction to jurisdiction.

Changes are periodically made to the information herein – which will be 
incorporated in revised editions of the publication. Maxtor may make changes 
or improvements in the product(s) described in this publication at any time 
and without notice. This product tested to comply with FCC standards for 
home or office use.
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Introduction

Thank you for selecting a Maxtor product.Your Maxtor OneTouch 

drive is an external hard drive that allows you to add storage to your 
computer to hold and organize your documents, videos, music, 
photos, graphics, and more. 

You can also use your new drive to make copies of critical files
as a part of your overall backup solution. By using the Maxtor
OneTouch feature, your drive can create and store a copy
of your important files with a touch of a button. 

Whether you use the drive for additional storage, to create a copy 
of your files, or both, this guide will get you up and running and pro-
vide helpful tips for using your drive. 

The Maxtor OneTouch drive has the following features:

• Large capacity
• Maxtor OneTouch feature: the easy way to make

a backup copy of your files
• Plug and Play installation

• Stacks and stands upright to fit on your desk
• Expandable so you can connect up to 63 drives via FireWire 

(Firewire and Combo Models) or 127 USB 2.0 drives with 
USB 2.0 hubs

• Hot-swappable to move the drive between computers
• Power Management features to conserve energy when your 

drive isn’t being used
• Compatible with security locking cables, including

those offered by Kensington®

1
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• High-speed performance
• USB 1.1 and 2.0 

(Available with USB and Combo models)

• FireWire®/1394/i.LINK®

(Available with FireWire and Combo models)
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OneTouch Drive Components
Before installing your new drive, review the features shown
in Figure 1.

Refer to the capacity label on the front of the box of your OneTouch-
drive to determine which model that you have.

Figure 1.  OneTouch Drive Features

Included in this Kit

The Maxtor OneTouch drive comes complete with the components 
shown in Figure 2. Familiarize yourself with each of these items 
prior to installation.

USB Port
(USB and Dual-

Interface models)

Firewire Ports
(FireWire and Dual 
Interface models)

Status Light
Flashing Blue 

Lights

Maxtor
OneTouch

Button

Security 
Locking Slot

Front Back

Power 
Connector

Power
Switch

User’s Guide

Vertical StandInstall CD

EXTERNAL HARD DRIVE

Maxtor OneTouch
User’s Guide

P/N:20234200

(See “Adding Rubber Feet to Your OneTouch Drive” on 
page 48 in chapter 3, for installation instructions)

Rubber Feet

Maxtor OneTouch Drive

Power adapter
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Figure 2.  Included in this Kit
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Combo model includes:

System Requirements
The following are the minimum system requirements. 

Windows

• Pentium II-class equivalent processor or later, including Intel-
compatible AMD processors

• Windows® 98SE, Me, 2000 Professional, or XP
• CD-ROM drive
• 32 MB RAM or more as required by Windows
• Available FireWire/1394/i.LINK or

USB 1.1 or 2.0 port depending on model

NOTE: USB 1.1 is slower than USB 2 or FireWire
• Internet connection (for system updates)

For faster operation, add a FireWire port to your PC with Maxtor’s 
1394/FireWire PCI Card. Available at http://www.maxstore.com in 
North America.

Macintosh

• Mac OS 9.1 or higher or Mac OS X versions 10.1.2 - 10.1.5
and versions 10.2.4 or higher

• CD-ROM drive
• 32 MB RAM or more as required by Mac OS

USB model includes:

‘A’ to ‘B’ USB cable

The ‘A’ connector, typically, plugs into 
your computer and the ‘B’ connector 
plugs into your Maxtor Drive.

If your computer has a different type 
of USB connection, you can purchase 
the correct type of cable from your local computer store.

‘A’ connector ‘B’ connector

FireWire model includes:

6-pin to 6-pin FireWire cable for 
connecting your Maxtor drive to 
your computer.

Many laptop computers, have a 
smaller 4-pin FireWire port requiring a 
special 4-pin to 6-pin FireWire cable. 
This is not included, but available for purchase at: 
http://www.maxstore.com or a standard computer store.

6-pin connector
Introduction 3

‘A’ to ‘B’ USB cable and 6-pin to 6-pin FireWire cable

Though this model has both USB and FireWire interfaces, 
it is only possible to use one at a time.

• Available FireWire or USB 1.1 or 2.0 port 
depending on model

• Internet connection (for system updates)
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Handling Precautions 
Handle your drive with care! Follow the precautions listed here
or damage to the drive may result and your warranty may become 
void. Review the “Maxtor Product Warranty” on the inside front 
cover for more information.

The following precautions can prevent loss of data:

• Do not bump, jar, drop the drive or move while in operation.
• Do not stack drives more than two high.
• Do not set the drive on its side without using the vertical 

stand as it may fall over and cause damage.
• Do not remove any cables or power cords without properly 

disconnecting the drive through the operating system. 
• Do not set any liquids or drinks on the drive. Liquids will 

damage the internal electronics.
• Do not attempt to open the drive’s case. This will void

your warranty.

About this Guide
The following symbols and conventions are used in this guide:

Where to Go for Help
For additional help with your drive, its installation and the
software, contact one of the following:

Maxtor Support

Maxtor provides a comprehensive product support section
on its web site, including the latest drivers, user guides, and
the Knowledge Base at http://www.maxtorkb.com (answers to 
common questions and problems). 

For support in Europe and the Middle East, go to:

Bold Used for menu, command, and keyboard
selections you make and screens you will see.

Italics Used for emphasis and to identify new terms,
which may also be defined in the Glossary.

Helpful information about a particular topic.

Important information to prevent problems and
ensure that you are successful in using the drive.
4 

http://www.maxtorsupport.com

Check the Maxtor support web site under Contact Us for
additional support phone numbers outside the USA.

For technical support in Asia Pacific regions, please e-mail to 
ApacTech_Assistance@Maxtor.com
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If you do not have Internet access, you can call: 

1-800-2-MAXTOR (in the United States)

+1 303 678 2015 (Outside the continental United States)

Dantz Support

Contact Dantz® Development Corporation for help with
Retrospect® software, making backup copies with Maxtor
OneTouch, or restoring files. Dantz provides free telephone support 
for the first 30 days and a comprehensive support section on its 
web site, including the latest software downloads, Knowledge 
Base (answers to common questions and problems), hardware 
compatibility and contact information.

On the Web: http://www.dantz.com 

Select the link labeled Support & Hardware.

Check the Dantz web site for additional support phone numbers 
outside the USA.

If you do not have Internet access, you can call: 

1-888-777-5664 (in the United States)

+1 925 253 3050 (Outside the continental United States)
Introduction 5
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Installing Your Drive

This chapter describes how to install the Maxtor OneTouch™ drive, 
the Dantz Retrospect backup software, and how to activate the 
Maxtor OneTouch button for simplified backups of your valuable 
data anytime you need them. To ensure a successful installation, 
follow the steps outlined below.

Please do not connect the drive to your computer until after 
you have installed the software.

Follow these steps to install your drive
Step 1. Install the software.
Step 2. Connect the drive to your computer. 
Step 3. Set up the Maxtor OneTouch button.

Software Installation Options
There are two options for the software installation:

• Full Installation (Recommended) 
Installs the Maxtor software drivers necessary for the 

Select your operating system
The complete, step-by-step installation for popular Windows and 
Macintosh operating systems is described separately in the 
following sections. Simply find the section for your operating 
system and follow the steps to get your OneTouch drive up and 
running.

• Windows 2000 and XP: See below.

• Windows 98SE and ME: See “Windows 98SE and ME: 
Installing the Software” on page 13

• Macintosh OS X: See “Macintosh OS X: Installing the 
Software” on page 20

• Macintosh OS 9: See “Macintosh OS 9: Installing the 
Software” on page 27

Windows 2000 and XP: 

2
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OneTouch drive to operate, the OneTouch Utility program and 
the Dantz Retrospect backup software that allows you to 
backup data at the touch of a button.

• Custom Installation
Installs ONLY Maxtor drivers and OneTouch Utility program. 

Installing the Software
If you get an error message regarding Administrator 
priviledges, refer to “Administrator Privilege for Windows” 
on page 71 in chapter 6.

1. Turn on your computer
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2. Insert the Maxtor Installation CD into your CD-ROM drive. After 
a few seconds, the Maxtor Installer screen will open.

3. Select your language. 

The Main Menu will appear next.

4. Select Install Software. 

The Install Software screen will appear.

5. Select Full Installation or Custom Installation.
(Full Installation is recommended.) 

Note: If you do not install the Retrospect program, you will not 
be able to use it with the OneTouch backup feature described 
later in this guide.

It may take a few seconds for the next screen to appear.

If a message appears asking you to restart, follow the onscreen 
directions to Restart your computer. (Please do not eject the 
Installer CD.) 

Once your computer restarts, you will see the next screen.

The InstallShield welcome screen will open.

6. Click Next. 

8. Enter your User Name and Company Name. 

If there are separate users that log in to use your computer, you 
can choose whether you would like all users to be able to use 
your OneTouch drive or just you. The All Users option is 
recommended.

Make your choice and click Next. 

The Choose Destination Location screen will appear. 

9. In the Destination Folder section of the screen, you can see 
where the Maxtor software will be installed. If you wish to 
change this, click Browse and choose a new location. 

When your are ready, click Next.

The Select Program Folder screen will appear.

10. You can see the name of the Maxtor program folder and where 
it will appear in the Windows Start Menu. You can make 
changes to these settings, if you need to.

When you are ready, click Next. 

The Setup Status window should appear briefly, then the 
InstallShield Wizard Complete window should appear.
7

The License Agreement screen will appear.

7. After reading the License Agreement, click Yes. 

The Customer Information screen will appear.

11. Click Finish.

You may see a message asking you to Please Reboot your 
computer. If so, select: ‘Yes, I want to restart my computer 
now’ and click OK. 

After your computer restarts, go to the next step. 
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(Please do not eject the Install CD.) 

If you don’t see the Please Reboot message, move to the 
next step.

If you have chosen not to not install Retrospect, move to the 
Connecting the Drive section on the next page.

12. The Retrospect 6.0 Installshield Wizard will appear.

click Next. 

The License Agreement screen should now appear.

13. After reading the agreement, select “I accept. .” and 
click Next.

The Customer Information screen will appear.

14. Fill in your information and click Next.

The Setup Type screen will appear.

15. You can choose the Complete Installation (recommended) to 
install all of the Retrospect Software or Custom Installation to 
choose individual components and specify an install location.

Note: If you do not install the Retrospect program, you will not 
be able to use it with the OneTouch backup feature described 

16. After the software is installed on your system, a message is 
displayed “InstallShield Wizard completed” signifying that 
your installation was successful. 

17. Click the Finish button.

18. Please remove the Maxtor Install CD from your computer.

19. Proceed to the next section: Connecting the Drive.

Windows 2000 and XP: 
Connecting the Drive
The Maxtor OneTouch Drive connects to your computer using 
either a Firewire or USB interface. Make sure you know which 
interface is available on your drive and on your computer. 

Please Install the software BEFORE you connect the drive.

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter. 
Installing Your Drive 8

later in this guide.

Make your choice and click Next.

The Ready to Install screen appears. If you’re ready to install 
the Retrospect software, click Install to begin installing the 
software on your computer.

Figure 3.  Connecting the Power
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3. Plug the standard electrical plug from the power adapter into 
your power source.

4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front should 
illuminate.

5. Determine whether you have USB or FireWire ports available 
on your system. If you are connecting your drive with FireWire, 
proceed to “Connecting with the FireWire Cable” on page 10.

Connecting with the USB Cable

If you have a OneTouch drive with both USB and FireWire 
interfaces, do not plug a USB cable into the drive when a 
FireWire cable is already connected to the drive. The 
OneTouch drive will only operate with one interface at 
a time. 

To connect the USB cable

1. Plug the larger end of the USB cable into any available
USB port on your computer. This USB logo ™
may help you identify a USB port.

2. Plug the smaller end of the USB cable into the USB connection 
on the drive. 

Figure 4.  Connecting to the USB Port

It may take up to 2 minutes for your computer to recognize 
the drive, after connecting it to your computer.

Your system may request you to restart your computer to 
complete the hardware installation. If so, go ahead and 
restart.

Your new untitled drive appears in the same way as your other 
drives with the name with a new drive letter assigned to it by the 
operating system. The assigned letter will vary depending upon the 
number of other drives connected to your computer. Make a 
mental note of this drive letter.

It’s a good idea to name your new drive, so that is easy to identify 

USB Port
USB Port
9

later when you use it for backing up your system. To name it:

1. Open your My Computer icon (where your other 
drives appear.)
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2. Right-click your new drive’s icon and select Properties.

The Properties window will open.

3. In the Label section at the top of the window, enter a name for 
your drive. For example: ‘Maxtor.’

If you’re running Windows 2000 or XP, Maxtor 
suggests re-formatting your drive for best 
performance and operation. If you plan to connect 
this drive to a computer runningWindows 98 or ME, 
however, you will need to keep the drive in its 
original format. More information is provided in 
“Formatting Your Drive for Windows” on page 34. 

The installation is complete and your Maxtor OneTouch drive 
is ready to use!

If you did the Full Installation, including Retrospect, we encourage 
you to proceed to setup the Maxtor OneTouch feature for easy, 
automated backup of your important files, anytime, at the touch of 
a button! Simply go to “Windows 2000 and XP: Setting Up the 
Maxtor OneTouch Feature” on page 11.

Connecting with the FireWire Cable

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 
go to http://www.askfor1394.com.

To connect the FireWire cable

1. Plug one end of the FireWire cable into any available FireWire 
port on your computer.

Many laptop computers, have a smaller 4-pin FireWire port 
requiring a special 4-pin to 6-pin FireWire cable (not included). 

2. Plug the other end of the FireWire cable into an
available FireWire port on the back of the drive. 

If your computer has a 4-pin
FireWire connection, you can 
purchase a 6-pin to 4-pin cable 
from http://www.maxstore.com 
or your local computer store.

4-pin connector

FireWire Ports
FireWire Ports
Installing Your Drive 10

Do not plug a FireWire cable into the drive when a USB 
cable is already connected to the drive. This drive will 
only operate on one interface at a time. Figure 5.  Connecting to a FireWire port

It may take up to 2 minutes for your computer to recognize 
the drive, after connecting it to your computer.
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Your new untitled drive appears in the same way as your other 
drives, with a new drive letter assigned by the operating system. 
The assigned letter will vary depending upon the number of other 
drives connected to your computer. Make a mental note of this 
drive letter.

It’s a good idea to name your new drive, so that is easy identify 
later when you use it for backing up your files. To name it:

1. Open your My Computer icon (where your other 
drives appear.)

2. Right-click your new drive’s icon and select Properties.

The Properties window will open.

3. In the Label section at the top of the window, enter a name for 
your drive. For example: ‘Maxtor.’

If you’re running Windows 2000 or XP, Maxtor suggests re-
formatting your drive for best performance and operation. 

If you plan to connect this drive to a computer running
Windows 98 or ME, however, you will need to keep the 
drive in its original format. More information is provided in 
“Formatting Your Drive for Windows” on page 34.

4. The installation is complete and your Maxtor OneTouch drive is 
ready to use.

Windows 2000 and XP: Setting Up 
the Maxtor OneTouch Feature
Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

Windows XP: you may see an alert box regarding a 
requirement for administrator privileges. Proceed with

your installation. For further information, refer to “Administrator 
Privilege for Windows” on page 71 in chapter 6.

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 

The Welcome to Retrospect screen appears. A license code is 
automatically entered for you, do not change this code.

Retrospect is not licensed for Windows 2000 Server.

2. Click OK to proceed.

The next screen will appear: 
‘Would you like to register Retrospect Express now?’

3. Choose Register Now, Register Later or Already Registered.
11

If you did the Full Installation, including Retrospect, we encourage 
you to proceed to the next section to setup the Maxtor OneTouch 
feature for easy, automated backup of your important files, 
anytime, at the touch of a button! 

If you chose Register Now, go to the next step. 

If you chose Register Later or Already Registered, 
Retrospect will open. Go directly to Step 5.

4. Enter the required information on the form. 
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• Click Email to register via email

• Click Print to register via mail

• Click Register Later if you do not want to register at this time.

By registering1 your new drive, you will have the
option of receiving product updates, special offers,
and important information about other data storage solutions 
from Maxtor.

5. Once you’ve made your selection, Retrospect will open and 
the Maxtor OneTouch Setup screen will appear.

6. Click Next.

The Step 1 screen will appear.
7. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

8. Choose the type of files to copy: 

Just Documents copies only documents you have created, 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 

Applications and Documents copies application files in 
addition to documents. This selection allows you to restore an 

1. Your registration information is collected and maintained according 
to the Dantz and Maxtor privacy policies located on their respective 
Installing Your Drive 12

application file if it has become damaged. 

This selection does not copy your operating system, registry 
(Windows) files, or Internet cache files.

If you want to create a full backup of your entire system, go to 
“Backing up your complete system” on page 55 in chapter 4. 

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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Make your choice and click Next. 

9. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 
must be different.

The “Congratulations... now ready” screen appears. 

10. To complete the Maxtor OneTouch setup, click Finish. 

If you would like to do your first backup immediately, click the 
Start Now button. Retrospect will copy your files and the 
message: ‘Execution completed successfully’ will appear.

When you are finished, you can Exit Retrospect.

11. Go to the File menu and choose Exit. 

You are now ready to use the Maxtor OneTouch feature. 

Each time you touch the button, Retrospect makes a copy of the 
folders and files on your source drive exactly as
they exist at that time.

The OneTouch button may not function when Retrospect is 
already running. To correct the problem, go to the File menu 

Windows 98SE and ME: 
Installing the Software
1. Turn on your computer

2. Insert the Maxtor Installation CD into your CD-ROM drive. After 
a few seconds, the Maxtor Installer screen will open.

3. Select your language. 

The Main Menu will appear next.

4. Select Install Software. 

The Install Software screen will appear.

5. Select Full Installation or Custom Installation.
(Full Installation is recommended.) See Software Installation 
Options on page 1 of this chapter for more information.

Note: If you do not install the Retrospect program, you will not 
be able to use it with the OneTouch backup feature described 
later in this guide.

It may take a few seconds for the next screen to appear.

If a message appears asking you to restart, follow the onscreen 
directions to Restart your computer. (Please do not eject the 
Installer CD.) 
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in Retrospect, and choose Exit.

Your hardware and software installation is now complete. See 
“Using Your Drive” on page 37 in chapter 3. for information on 
using your drive for common applications and on using Retrospect 
to make copies of your important files and restore copied files.

The InstallShield welcome screen will appear.

6. Click Next.

The License Agreement screen will appear.
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7. After reading the License Agreement, click Yes. 

The Customer Information screen will appear.

8. Enter your User Name and Company Name. 

Click Next. 

The Choose Destination Location screen will appear. 

9. In the Destination Folder section of the screen, you can see 
where the Maxtor software will be installed. If you wish to 
change this, click Browse and choose a new location. 

When your are ready, click Next.

The Select Program Folder screen will appear.

10. You can see the name of the Maxtor program folder and where 
it will appear in the Windows Start Menu. You can make 
changes to these settings, if you need to.

When your are ready, click Next. 

11. The Driver Information Database window will appear. 

After short time, it will close and the installation will begin.

When the installation completes, the InstallShield Wizard 

13. Select ‘Yes, I want to restart my computer now’ and
click OK

Your computer will now restart. 

Please do not eject the Install CD unless you have chosen not 
to install the Retrospect Express software. 

14. When your computer restarts, an operating system window 
will appear while the installation of your drive is completed.

After a short time, this window will close.

If you chose Custom Install earlier to not install Retrospect, you 
can move to “Connecting with the FireWire Cable:” on 
page 16.

Otherwise, the Retrospect Welcome screen will appear.

15. Click Next. The License Agreement screen should now appear.

16. After reading the agreement, select “I accept. .” and 
click Next.

The Customer Information screen will appear.

17. Fill in your information and click Next.

The Setup Type screen will appear.
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Complete window should appear.

12. Click Finish.

The Please Reboot screen should appear.

18. You can choose the Complete Installation (recommended) to 
install all of the Retrospect Software or Custom Installation to 
choose individual components and specify an install location.

Make your choice and click Next.
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The Ready to Install screen appears. If you’re ready to install 
the Retrospect software, click Install to begin installing the 
software on your computer.

19. After the software is installed on your system, a message is 
displayed “InstallShield Wizard completed” signifying that 
your installation was successful. 

20. Click the Finish button.

21. Please remove the Maxtor Install CD from your computer.

22. Proceed to the next section: Connecting the Drive.

Windows 98SE and ME: 
Connecting the Drive
The Maxtor OneTouch Drive connects to your computer using 
either a Firewire or USB interface. Make sure you know which 
interface is available on your drive and on your computer to 
determine which interface is available. 

Please Install the software BEFORE you connect the drive.

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter. 

Figure 3.  Connecting the Power

3. Plug the standard electrical plug from the power adapter into 
your power source.

4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front of the 
drive should illuminate.

5. Determine whether you have USB or FireWire ports available 
on your system. If you are connecting your drive with FireWire, 
proceed to “Connecting with the FireWire Cable” on page 23.

Connecting with the USB Cable

If you have a OneTouch drive with both USB and FireWire 
interfaces, do not plug a USB cable into the drive when a 
FireWire cable is already connected to the drive. The 
OneTouch drive will only operate with one interface at 
15

a time. 

To connect the USB cable

1. Plug the larger end of the USB cable into any available
USB port on your computer. This USB logo ™
may help you identify a USB port.
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2. Plug the smaller end of the USB cable into the USB connection 
on the drive. 

Figure 4.  Connecting to the USB Port

It may take up to 2 minutes for your computer to recognize 
the drive, after connecting it to your computer:

1. Your new drive appears in the same way as your other drives 
with the name New Volume and a drive letter assigned by the 
operating system. The assigned letter will vary depending upon 
the number of other storage devices connected to your 
computer. Make a mental note of this drive letter.

Your system may request you to restart your computer 
to complete the hardware installation. If so, go ahead 
and restart.

It’s a good idea to name your new drive, so that is easy to 

3. right-click your new drive’s icon and select Properties.

The Properties window will open.

4. In the Label section at the top of the window, enter a name for 
your drive. For example: ‘Maxtor.’

5. The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect, we encourage 
you to setup the Maxtor OneTouch feature for easy, automated 
backup of your important files, anytime, at the touch of a button! 
Simply go to “Windows 98SE and ME: Setting Up the Maxtor 
OneTouch Feature” on page 18.

Connecting with the FireWire Cable:

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 
go to http://www.askfor1394.com.

Do not plug a FireWire cable into the drive when a USB 
cable is already connected to the drive. This drive will only 
operate on one interface at a time. 

Windows 98SE Only:

(If you are using Windows ME, please move on to the next 
section: ‘To Connect the FireWire Cable’)

USB Port
USB Port
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identify later when you use it for backing up your files. Here’s 
how to do it:

2. Open your My Computer icon (where your other 
drives appear.)

Make sure you have first installed the Windows 98SE 1394 
Storage Supplement. 

This Microsoft supplement installs a Safe Removal utility that 
allows you to safely stop a Plug and Play storage device prior to 
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physically unplugging the device. This supplement also includes 
an update for the FireWire/1394 drivers. 

Once your drive is installed, look in the System Tray, located at 
the bottom right of your desktop, for the icon shown in the 
following figure.

If the icon is not displayed, you need to install the 1394 Storage 
Supplement. 

a. While connected to the internet, go to the Microsoft 
Support web site at http://support.microsoft.com.

b. In the upper left corner, select Windows 98 from the 
Search the Knowledge Base drop-down menu and click 
the Show options item.

c. Select the option to search Article ID and enter “Q242975” 
in the field labeled For solutions containing...

d. The search should return an item called: Update for 1394 
Storage Peripherals in Windows 98 Second Edition 
(Q242975). Click this link and go to the article.

e. Inside this article, click on the link: http://
www.microsoft.com/windows98/downloads/contents/
WURecommended/S_WUFeatured/1394/Default.asp.

To Connect the FireWire Cable

1. Plug one end of the FireWire cable into any available FireWire 
port on your computer.

Laptop Users – Many laptop computers, have a smaller 4-
pin FireWire port requiring a special 4-pin to 6-pin FireWire 
cable (not included).

2. Plug the other end of the FireWire cable into an
available FireWire port on the back of the drive. 

Unplug or Eject
Hardware icon

FireWire Ports FireWire Ports

If your computer has a 4-pin
FireWire connection, you can pur-
chase a 6-pin to 4-pin cable from 
http://www.maxstore.com or your 
local computer store.

4-pin connector
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f. Download and install this Windows update as instructed.

g. Later, when you connect the drive to your computer, a 
window will appear three (3) times called “Version 
Conflict.” Click Yes each time to keep the existing files.

Figure 5.  Connecting to a FireWire port

It may take up to 2 minutes for your computer to recognize 
the drive, after connecting it to your computer:
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3. Your new untitled drive appears in the same way as your other 
drives with a new drive letter assigned by the operating 
system. The assigned letter will vary depending upon the 
number of other storage devices connected to your computer. 
Make a mental note of this drive letter.

It’s a good idea to name your new drive, so that it is easy to 
identify later when you use it for backing up your files.

4. To name your new drive, right-click it’s icon and 
select Properties.

The Properties window will open.

5. In the Label section at the top of the window, enter a name for 
your drive. For example: ‘Maxtor.’

6. The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect, we encourage 
you to proceed to the next section to setup the Maxtor OneTouch 
feature for easy, automated backup of your important files, anytime, 
at the touch of a button! 

Windows 98SE and ME: Setting Up the 
Maxtor OneTouch Feature

The Welcome to Retrospect screen appears. A license code is 
automatically entered for you, do not change this code.

2. Click OK to proceed.

The next screen will appear: 
‘Would you like to register Retrospect now?’

3. Choose Register Now, Register Later or Already Registered.

If you chose Register Now, go to the next step. 

If you chose Register Later or Already Registered, 
Retrospect will open. Go directly to Step 5.

4. Enter the required information on the form. 

• Click Email to register via email

• Click Print to register via mail

Click Register Later if you do not want to register at this time.

By registering1 your new drive, you will have the option of 
receiving product updates, special offers, and important 

1. Your registration information is collected and maintained according 
to
the Dantz and Maxtor privacy policies located on their respective 
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Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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information about other data storage solutions from Maxtor.
Once you’ve made your selection, Retrospect will open and 
the Maxtor OneTouch Setup screen will appear.

5. Click Next.

The Step 1 screen will appear.

6. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

addition to documents. This selection allows you to restore an 
application file if it has become damaged. 

This selection does not copy your operating system, registry 
(Windows) files, or Internet cache files.

If you want to create a full backup of your entire system, go to 
‘Chapter 4: Backing up your system.’

Make your choice and click Next. 

8. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 
must be different.

The “Congratulations... now ready” screen appears. 

9. To complete the Maxtor OneTouch setup, click Finish. 

If you would like to do your first backup immediately, click the 
Start Now button. Retrospect will copy your files and the 
message: ‘Execution completed successfully’ will appear.

When you are finished, you can Exit Retrospect.

10. Go to the File menu and select Exit. 
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7. Choose the type of files to copy: 

Just Documents copies only documents you have created, 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 

Applications and Documents copies application files in 

You are now ready to use the Maxtor OneTouch feature. 

Each time you touch the button, Retrospect makes a copy of the 
folders and files on your source drive exactly as
they exist at that time.
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The OneTouch button may not function when Retrospect is 
already running. To correct the problem, go to the File 
menu in Retrospect, and choose Exit.

Your hardware and software installation is now complete. See 
“Using Your Drive” on page 37 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
to make copies of your important files and restore copied files.

Macintosh OS X: Installing the Software
1. Turn on your computer

2. Insert the Maxtor Installation CD into your CD-ROM drive. 

After a few seconds, the Install CD should appear on your 
Macintosh’s desktop.

3. Open the Install CD Icon.

4. Find the folder appropriate for your language and open it.

5. Double-click the Install Retropsect Express icon.

The Authenticate window will open.

6. Enter your Name and Password for your OS X system.

7. Click Continue.

The license screen will appear. 

8. Review license agreement and Accept to continue.

The Install Retrospect Express screen will appear.

9. This screen allows you to specify what type of installation you 
want and where. It is automatically setup to do a Full 
Installation (Recommended) into the Applications folder on your 
Macintosh.

You can select a Custom Installation, using the Easy Install 
menu, as well as change the location of the installation using 
the Install Location menu at the bottom of the screen.

When you are ready, Click Install.

The installation will begin.

10. When the installation is complete, the Installation was 
successful screen should appear, asking you to Restart.

11. Click Restart. 

12. After your Macintosh restarts, please remove the Maxtor 
Install CD from your computer.
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(This is the Name and Password you set up when you originally 
installed OS X)

Click OK.

The Retrospect Express Installer will open.

13. Proceed to the next section: Connecting the Drive.
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Macintosh OS X: Connecting the Drive
The Maxtor OneTouch Drive connects to your computer using 
either a Firewire or USB interface. Make sure you know which 
interface is available on your drive and on your computer to 
determine which interface is available. 

Please install the software BEFORE you connect the drive.

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter.

Figure 6.  Connecting the Power 

3. Plug the standard electrical plug from the power adapter into 
your power source.

5. Determine whether you have USB or FireWire ports available 
on your system. If you are connecting your drive with FireWire, 
proceed to “Connecting with the FireWire Cable” on page 23.

Connecting with the USB Cable

If you have a OneTouch drive with both USB and FireWire 
interfaces, do not plug a USB cable into the drive when a 
FireWire cable is already connected to the drive. The 
OneTouch drive will only operate with one interface at 
a time. 

The Maxtor OneTouch button, Power management, and 
OneTouch Settings utility program are not supported for USB 
on the Macintosh. You may, however, use your drive as 
external storage and utilize the Retrospect software to 
maintain backup copies of your files and complete system.

To connect the USB cable

1. Plug the larger end of the USB cable into any available
USB port on your computer. This USB logo ™
may help you identify a USB port.
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4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front of the 
drive should illuminate.



2

2. Plug the smaller end of the USB cable into the USB connection 
on the drive. 

Figure 7.  Connecting to the USB Port

3. Depending on the size of your drive and version of OS X, your 
next step will vary. Find your version of OS X in the table below 
to determine your next step.

4. Click Initialize.

The Disk Utility program opens.

(If a second window appears with the message: “A Disk 
attempting to mount as Untitled has failed,” click OK)

5. Select your new drive from the list on the left.

Make sure you select your new drive.
This utility will erase all data on the drive. 

Table 1: Capacity Under 137 GB

OS Version Message Your next step

OS X 10.1

Message appears 
saying OS X is 
unable to read 

volume.

Go to Step 4.

USB Port

USB Port

Table 2: Capacity Over 137 GB

OS Version Message Your next step

OS X 10.1

Message appears 
saying OS X is 
unable to read 

volume. 

Go to Step 4.

OS X 10.2

Drive doesn’t 
appear on the 

Desktop.

Open the Apple Disk Utility 
located in the Utilities folder 
within the Applications folder 

on your Macintosh and 
proceed to Step 5.
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OS X 10.2 Drive mounts as 
“Untitled Volume.”

Open the Apple Disk Utility 
located in the Utilities folder 
within the Applications folder 

on your Macintosh and 
proceed to Step 5.
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A description of the drive appears in the window.

The actual information in this window will vary depending on 
the model and capacity of your drive.

6.Select the Erase tab at the top of the window.

This will allow your disk to be recognized if you start your 
system in Mac OS 9. (If you will never use this drive with OS 9, 
you can leave this unchecked).

10. Click Erase to continue.

The Erase Disk window appears to confirm the Erase process.

11. Click Erase to start the formatting process.

After a few minutes, your drive will be formatted with the Mac OS 
Extended format and you will be able to see it appear on the 
desktop of your Macintosh.

12. In the Disk Utility program, go to the File menu and 
select Quit.

13. The installation is complete and your Maxtor OneTouch drive is 
ready to use!

Connecting with the FireWire Cable

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 
go to http://www.askfor1394.com.

Do not plug a FireWire cable into the drive when a USB 
cable is already connected to the drive. This drive will only 
operate on one interface at a time. 
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7. Select Mac OS Extended from the Volume Format
drop-down list.

8. Enter a name for your drive in the Name field.

9. Select the check box next to Install Mac OS 9 Drivers. 

To connect the FireWire cable

1. Plug one end of the FireWire cable into any available FireWire 
port on your computer or to any other FireWire device that is 
connected to your computer.
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2. Plug the other end of the FireWire cable into an
available FireWire port on the back of the drive. 

Figure 8.  Connecting to a FireWire port

3. Depending on the size of your drive, version of OS X, your next 
step will vary. Find your version of OS X in the table below to 
determine your next step.

4. Click Initialize.

The Disk Utility program opens.

5. Select your new drive from the list on the left.

Make sure you select your new drive.
This utility will erase all data on the drive. 

A description of the drive appears in the window.

Table 3: Capacity Under 137 GB

OS Version Message Your next step

OS X 10.1

Message appears 
saying OS X is 
unable to read 

volume.

Go to Step 4.

FireWire 
Ports

FireWire Ports

Table 4: Capacity Over 137 GB

OS Version Message Your next step

OS X 10.1

Message appears 
saying OS X is 
unable to read 

volume. 

Go to Step 4.

OS X 10.2

Drive doesn’t 
appear on the 

Desktop.

Open the Apple Disk Utility 
located in the Utilities folder 
within the Applications folder 

on your Macintosh and 
proceed to Step 5.
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OS X 10.2 Drive mounts as 
“Untitled Volume.”

Open the Apple Disk Utility 
located in the Utilities folder 
within the Applications folder 

on your Macintosh and 
proceed to Step 5.
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The actual information in this window will vary depending on 
the model and capacity of your drive.

6.Select the Erase tab at the top of the window.

7. Select Mac OS Extended from the Volume Format
drop-down list.

8. Enter a name for your drive in the Name field.

9. Select the check box next to Install Mac OS 9 Drivers. 
This will allow your disk to be recognized if you start your 
system in Mac OS 9. (If you will never use this drive with OS 9, 
you can leave this unchecked).

10. Click Erase to continue.

After a few minutes, your drive will be formatted with the Mac OS 
Extended format and you will be able to see it appear on the 
desktop of your Macintosh.

12. In the Disk Utility program, go to the Disk Utility menu and 
select Quit Disk Utility.

13. The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect Express, we 
encourage you to go to the next section to setup the Maxtor One-
Touch feature for easy, automated backup of your important files, 
anytime, at the touch of a button! 

Macintosh OS X: Setting Up the 
Maxtor OneTouch Feature
Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

Before you begin, make sure the Maxtor Install CD is NOT 
in your CD-ROM drive. 

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 
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The Erase Disk window appears to confirm the Erase process.

11. Click Erase to start the formatting process.

A window appears that says: ‘You need an administrator 
password to start Retrospect’

Enter your Name and Password for your OS X system.

(This is the Name and Password you set up when you originally 
installed OS X)
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2. Click OK.

The next screen will appear: 

‘Would you like to register Retrospect Express now?’

3. Choose Register Now, Register Later or Already Registered.

If you chose Register Now, go to the next step. 

If you chose Register Later or Already Registered, 
Retrospect Express will open. Go directly to Step 5.

4. Enter the required information on the form. 

• Click Email to register via email

• Click Print to register via mail

• Click Register Later if you do not want to register at this time.

By registering1 your new drive, you will have the option of 
receiving product updates, special offers, and important 
information about other data storage solutions from Maxtor.

Once you’ve made your selection, Retrospect Express will 
open and the Maxtor OneTouch Setup screen will appear.

5. Click Next.

The Step 1 screen will appear.
 

6. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

7. Choose the type of files to copy: 1. Your registration information is collected and maintained according 
to the Dantz and Maxtor privacy policies located on their respective 
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Just Documents copies only documents you have created, 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 

Applications and Documents copies application files in 
addition to documents. This selection allows you to restore an 

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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application file if it has become damaged. Refer to the 
Retrospect User’s Guide for instructions on how to make
a complete system backup copy.

This selection does not copy your operating system files or 
Internet cache files.

If you want to create a full backup of your entire system, go to 
‘Chapter 4: Backing up your system.’

8. Make your choice and click Next. 

9. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 
must be different.

The “Congratulations... now ready” screen appears. 

10. To complete the Maxtor OneTouch setup, click Finish. 

11. Go to the Retrospect Express menu and choose Quit 
Retrospect Express to exit Retrospect Express. 

You are now ready to use the Maxtor OneTouch feature. 

Each time you touch the button, Retrospect Express makes a copy 
of the folders and files on your source drive exactly as

Your install is now complete. Push the OneTouch button to 
begin your backup.

See “Using Your Drive” on page 37 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
Express to make copies of your important files and restore copied 
files.

Macintosh OS 9: Installing the Software
1. Turn on your computer

2. Insert the Maxtor Installation CD into your CD-ROM drive. 

After a few seconds, the Maxtor CD should appear on your 
Macintosh’s desktop.

3. Open the Install CD icon.

4. Find the folder appropriate for your language and open it.

5. Double-click the Install Retrospect Express icon.

The Retrospect Installer will open.

6. Click Continue.
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they exist at that time.

The OneTouch button may not function when Retrospect 
Express is already running. To correct the problem, from 
the File menu in Retrospect, choose Quit.

Your hardware and software installation is now complete. 

The license screen will appear.

7. Review the license agreement and click Accept if you agree.

The Install Retrospect Express screen will appear.

This screen allows you to specify what type of installation you 
want and where. It is automatically setup to do an Easy Install 
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(full installation) which is recommended. It will install 
Retrospect Express into the Applications folder on your 
Macintosh.

You can select a Custom Installation, using the Easy Install 
pop-up menu, as well as change the location of the installation 
using the Install Location menu at the bottom of the screen.

8. When you are ready, click Install.

The installation will begin.

When the installation finishes, the Installation was successful 
window should appear, asking you to Restart.

9. Click Restart.

10. After your Macintosh restarts, please eject the Maxtor Install 
CD from your computer.

11. Proceed to the next section: Connecting the Drive.

Macintosh OS 9: Connecting the Drive
The Maxtor OneTouch Drive connects to your computer using 
either a Firewire or USB interface. Make sure you know which 
interface is available on your drive and on your computer to 
determine which interface is available. 

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter. 

Figure 3.  Connecting the Power

3. Plug the standard electrical plug from the power adapter into 
your power source.

4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front of the 
drive should illuminate.

5. Determine whether you have USB or FireWire ports available 
on your system. If you are connecting your drive with FireWire, 
proceed to “Connecting with the FireWire Cable” on page 30.
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Please install the software BEFORE you connect the drive.
Connecting with the USB Cable

If you have a OneTouch drive with both USB and FireWire 
interfaces, do not plug a USB cable into the drive when a 
FireWire cable is already connected to the drive. The 
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OneTouch drive will only operate with one interface 
at a time. 

Before you connect

Disable the File Exchange control panel:

• From the Apple menu, select Control Panels

The Control Panels folder will open.

• Double-click the Extensions Manager icon.

The Extensions Manager panel will open.

• From the list that appears, uncheck the check box next to the 
File Exchange control panel by clicking on it.

• Click Restart. 

After your Macintosh restarts, proceed to the next step.

The Maxtor OneTouch button, Power management, and 
OneTouch Settings utility program are not supported for USB 
on the Macintosh. You may, however, use your drive as 
external storage and utilize the Retrospect software to 
maintain backup copies of your files and complete system.

To connect the USB cable

1. Plug the larger end of the USB cable into any available

2. Plug the smaller end of the USB cable into the USB connection 
on the drive. 

Figure 4.  Connecting to the USB Port

Depending on the size of your drive, it may take several 
seconds for your Macintosh to recognize the drive. 

Eventually, this message will appear:

‘This disk is unreadable by this Computer.’

USB Port

USB Port
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USB port on your computer. This USB logo ™
may help you identify a USB port.

3. Enter a Name for your drive and select Mac OS Extended 
from the Format drop-down menu.

4. Click Initialize.
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A window will open that says: ‘Initializing will erase all 
information on this disk.’

5. Click Continue.

After a short time, your new drive will appear on the desktop of 
your Macintosh.

Now, you should re-enable the File Exchange control panel.

6. Go to the Apple menu, select Control Panels.

The Control Panels folder will open

7. Double-click the Extensions Manager icon to open it.

The Extensions Manager panel will open.

8. Check the checkbox next to File Exchange. (It should now 
be checked).

9. Click Restart.

The installation is complete and your drive is ready to use!

Connecting with the FireWire Cable

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 

Before you connect

Disable the File Exchange control panel:

• From the Apple menu, select Control Panels

The Control Panels folder will open.

• Double-click the Extensions Manager icon.

The Extensions Manager panel will open.

• From the list that appears, uncheck the check box next to the 
File Exchange control panel by clicking on it.

• Click Restart. 

After your Macintosh restarts, proceed to the next step.

To connect the FireWire Cable

1. Plug one end of the FireWire cable into any available FireWire 
port on your computer or any other FireWire device that is 
connected to your computer.
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go to http://www.askfor1394.com.

Do not plug a FireWire cable into the drive when a USB 
cable is already connected to the drive. This drive will only 
operate on one interface at a time. 
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2. Plug the other end of the FireWire cable into either of the 
available FireWire ports on the back of the drive. 

Figure 5.  Connecting to a FireWire port

Depending on the size of your drive, it may take several 
seconds for your Macintosh to recognize the drive. 

Eventually, this message will appear:

‘This disk is unreadable by this Computer.’

A window will open that says: ‘Initializing will erase all 
information on this disk.’

5. Click Continue.

After a short time, your new drive will appear on the desktop of 
your Macintosh.

Now, you should re-enable the File Exchange control panel.

6. Go to the Apple menu, select Control Panels.

The Control Panels folder will open

7. Double-click the Extensions Manager icon to open it.

The Extensions Manager panel will open.

8. Make sure the checkbox next to File Exchange has a 
checkmark in it.

9. Click Restart.

The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect Express, we 
encourage you to proceed to the next section to setup the Maxtor 
OneTouch feature for easy, automated backup of your important 
files, anytime, at the touch of a button!

FireWire 
Ports

FireWire Ports
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3. Enter a Name for your drive and select Mac OS Extended 
from the Format drop-down menu.

4. Click Initialize.
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Macintosh OS 9: Setting Up the 
Maxtor OneTouch Feature
Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

Before you begin, make sure the Maxtor Install CD is NOT 
in your CD-ROM drive. 

The OneTouch feature is not supported with USB on the 
Macintosh. 

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 

A window should appear: ‘Would you like to register 
Retrospect Express now?’

2. Choose either Register Now, Register Later or 
Already Registered.

If you choose Register Now, go to the next step. 

If you chose Register Later or Already Registered, 
Retrospect Express will open. Go directly to Step 4 - 
Maxtor OneTouch Setup.

By registering1 your new drive, you will have the option of 
receiving product updates, special offers, and important 
information about other data storage solutions from Maxtor.

4. Retrospect Express will open and the Maxtor OneTouch 
Setup screen will appear. 

Click Next. 

The Step 1 Screen will appear.

1. Your registration information is collected and maintained according 
to the Dantz and Maxtor privacy policies located on their respective 
Installing Your Drive 32

3. Enter the required information on the form. 

• Click Email to register via email

• Click Print to register via mail

• Click Register Later if you do not want to register at this time.

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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5. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

6. Choose the type of files to copy: 

Just Documents copies only documents you have created 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 

Applications and Documents copies application files in 
addition to documents. This selection allows you to restore an 
application file if it has become damaged. Refer to the 
Retrospect User’s Guide for instructions on how to make
a complete system backup copy.

This selection does not copy your operating system files or 
Internet cache files. If you want to create a full backup of 
your entire system, go to “Backing up your complete 
system” on page 55 in chapter 4.

Make your choice and click Next. 

7. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 

You are now ready to use the Maxtor OneTouch feature!

Each time you touch the button, Retrospect Express makes a copy 
of the folders and files on your source drive exactly as
they exist at that time. 

Depending on the amount of files, your first time backup, 
may take a long time. 

The OneTouch button may not function when Retrospect 
Express is already running. To correct the problem, go to 
the File menu in Retrospect, and choose Quit.

Your hardware and software installation is now complete. 

See “Using Your Drive” on page 37 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
Express to make copies of your important files and restore copied 
files.

The drive will not operate with more than one computer
at a time.

Maxtor does not support using the drive as a startup
disk for the Macintosh.

Using your OneTouch button for backup
33

must be different.
The “Congratulations...now ready” screen appears. 

8. To complete the Maxtor OneTouch setup, click Finish. 

9. Go to the File menu and choose Quit to exit 
Retrospect Express. 

Only the current versions of your files are saved. Backup 
copies made with the default Maxtor OneTouch feature do 
not include earlier versions of files you have deleted since 
the last time you pressed the Maxtor OneTouch button.
Any files that are currently open are not saved, so close any 
files you wish to be copied.
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You may customize Retrospect to create backup copies of 
your files which will include revisions made on a daily basis.
See the help system in Retrospect for Windows or the 
Retrospect Express User’s Guide for Macintosh, included on 
the install CD.

Your hardware and software installation is now complete. See 
“Using Your Drive” on page 37 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
to make copies of your important files and restore copied files.

Formatting Your Drive for Windows
Optional for Windows 98/2000/Me/XP

Your Maxtor OneTouch drive was formatted at the factory with the 
Windows FAT32 file system. This file system is compatible with 
Mac OS 9 and recent versions of the Windows operating system. 

The FAT32 file system limits any file to a maximum size
of 4 GB. If you are running Windows 98 or Me, consider 
upgrading to Windows 2000 or XP to take advantage of
the NTFS file system.
If you are running either the Windows 2000 or XP operating 
system, consider reformatting your drive to the NTFS file 
system. The NTFS file system provides several advantages, 
including support for very large files. See “Formatting Your 
Drive with NTFS” on page 35.
If you plan to share data between two Windows systems, 
review “Moving Data Between Two Systems” on page 47 in 
chapter 3.
Your new drive will display a drive capacity that is slightly less 
than the capacity stated on the box. This is normal. For a 
complete explanation, see“My drive shows less capacity 
than on the box label” on page 68 in chapter  6.
Installing Your Drive 34
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Formatting Your Drive with NTFS 

This section describes how to format your drive with the NTFS file 
system for Windows 2000 or XP.

Formatting the drive destroys all data contained on that 
drive. Make a backup copy of all your data before formatting 
your drive.

To format the drive for NTFS

1. Select Start Î Settings Î Control Panel.

2. Double-click Administrative Tools.

3. Double-click Computer Management.

4. Double-click Disk Management (located under the 
Storage icon).

To format into two or more logical partitions, use the 
partitioning feature in the Disk Management utility. For 
more information, press F1 to access Help and enter 
partition in the keyword field.

5. Right-click on the icon for your new drive in the window 
that appears. 

FAT32 should be listed in the column labeled File System.

6. Select Format from the menu.

Installing Drivers Only
This section describes how to install your new drive without 
installing Retrospect Express software.

The Maxtor OneTouch button feature will not function if you 
choose to install under this option.

Locate your operating system and the interface you plan to use in 
the following section and follow the corresponding installation 
procedure detailed.

Windows

Use the Custom Install feature on the Maxtor Install CD.

1. Insert the Install CD in your CD-ROM drive.

Wait for the Maxtor screen to appear.

2. Select Custom Install and follow the steps to on-screen steps 
to complete the installation.

Your drive is now ready to use.

Macintosh

No drivers are necessary. If you’re using OS 9, connect your 
OneTouch drive as described in “Macintosh OS 9: Connecting the 
Drive” on page 28. If you’re using OS X, connect your drive as 
described in “Macintosh OS X: Connecting the Drive” on page 21.
35

7. Select NTFS in the File System field.

8. Click OK when you are ready to format your drive.

Formatting time varies based on your system speed, the 
interface used, and the drive’s capacity.
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To Install Retrospect at a Later Time

If you wish to install a complete copy of Retrospect software and 
the Maxtor OneTouch feature at a later time, you can do so by fol-
lowing the original installation instructions provided in the “Setting 
Up the Maxtor OneTouch Feature” detailed earlier in this chapter 
for each operating system.
Installing Your Drive 36
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Using Your Drive

Once installed, you can use your new Maxtor OneTouch drive in the 
same way you use the other drives on your computer. Some of the 
basic ways you can use your new drive are:

• Move or copy files or folders from your other drives, CD-
ROMs, or other storage devices.

• Within virtually any application, save files to and open files 
from the new drive.

• Store video files, games, spreadsheets, and other commonly 
used files.

• Store copies of important files from your desktop or laptop 
computer.

This chapter offers additional suggestions on how to use your new 
drive.

OneTouch Drive lights and their messages
The blue lights on the front of your drive provide useful information.

Connecting and Disconnecting the Drive
The FireWire and USB interfaces allow you to hot swap your new 
Maxtor OneTouch Drive; that is, connect and disconnect the drive 
while the computer and your drive are running.

To connect the drive to a Windows system

1. Make sure the drive is turned on and that both blue 
lights are illuminated. 

Connecting your computer to a drive that is not powered on 
can cause your computer to behave erratically or freeze.

2. Plug the FireWire or USB cable into the drive and your 
computer. 

After a moment, the computer will recognize that your 
drive is connected and the drive icon will appear in the 
My Computer window. or on your Macintosh desktop.

To disconnect the drive from a Windows system

3

Table 1: OneTouch lights
Using Your Drive 37

1. Double-click the Windows Unplug or Eject Hardware 
icon in your system icon tray located at the bottom right 
corner of your desktop. 

Message Status

Both lights on Power on/ready to go

Alternating blinking Processing command/transferring data

One off and one blinking Power saving mode
Unplug or Eject 
Hardware icon
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A list of device choices appears. 

2. Select the Maxtor drive and follow the on-screen 
directions to eject the drive.

The system will display a message saying that you can 
safely remove the drive.

3. Disconnect the drive from your computer.

Your system may not allow you to disconnect the drive. In 
this case, you may need to close all open applications and 
documents or shut down your system completely to 
disconnect the drive safely.

Removing the drive from your computer without 
disconnecting it properly through the operating system can 
result in lost or damaged files. 

To connect the drive to a Macintosh system

1. Make sure the drive is turned on and that both blue 
lights are illuminated. 

Connecting your computer to a drive that is not powered on 
can cause your computer to behave erratically or freeze.

2. Plug the FireWire or USB cable into the drive and your 
computer. 

1. From the desktop, drag the drive icon to the Trash. 

The drive will disappear from the desktop.

2. Disconnect your drive from the computer.
38

After a moment, the computer will recognize that your 
drive is connected and the drive icon will appear on your 
Macintosh desktop.

To disconnect the drive from a Macintosh
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What is Maxtor OneTouch?
Maxtor OneTouch is an easy way to make backup copies of your 
files. By pressing the button on the front of your drive, your files are 
copied. It’s that simple.

How does the Maxtor OneTouch drive work?

Each time you touch the button, the Maxtor OneTouch drive opens 
up Dantz Retrospect backup software and makes a copy of the files 
on your source drive, exactly as they exist. 

Here are some important guidelines:

• Only the current versions of your files are copied. The Maxtor 
OneTouch drive does not keep backup copies made in 
earlier sessions.

• If you delete files from your source drive and then push the 
button, those same files will also be deleted from your Maxtor 
OneTouch drive.

• Any files that are currently open will not be copied to the 
Maxtor OneTouch drive. Close any files you want copied 
before pressing the button.

Can I customize the Maxtor OneTouch Backup?

Yes. Using Retrospect, you can customize OneTouch backup in a 
variety of ways. The default type is a duplicate backup (outlined 

will erase all files on the destination drive’s backup folder and will 
only copy the selected files from the source drive’s folder. 
Use with caution! 

It is strongly recommended that you: 

• Select the option to “Replace Corresponding Files” 
(see Figure 1) 

• Define a folder on the destination drive dedicated to your 
duplicate backups.

Figure 1.  
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in”How does the Maxtor OneTouch drive work?” above). You can 
even customize how the duplicate replaces files on the 
destination drive.

If you modify the destination location for the Maxtor OneTouch 
script or any other duplicate script in Retrospect, it will default to 
“replace the entire contents” of the selected drive or folder. This 
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Archiving files

Archive is another type of backup you can do with Retrospect. 
Note that using this function will permanently remove files from 
the source drive and place them on the destination drive. If your 
destination drive is lost or damaged, you will have lost your only 
copy of these files.

Can I do other types of backup?

Yes. Using Retrospect, you can also create a script to back up 
multiple revisions of each file or to back up multiple drives or 
folders to a single backup set. This is the second type of backup 
you can create and customize. To access files contained in the 
backup set, use the Retrospect software.

Note for Windows Users: the drive’s factory format (FAT32) will 
limit the size of any backup created using Retrospect backup 
format (not duplicate format) to 4GB. If you are running Windows 
2000 or XP, you can re-format your drive to the NTFS format, 
allowing any backup file to be only limited by the size of your hard 
drive. Macintosh users are required to format the drive to the 
Macintosh OS Extended format for use with the Maxtor OneTouch 
feature or Retrospect software. Refer to the User’s Guide 
(Macintosh) and Retrospect Help system (Windows) for details on 
formatting your drive.

More Information

Using Retrospect
Your Maxtor OneTouch drive includes a full copy of the Dantz 
Retrospect software. The Retrospect software includes many 
powerful and convenient features. In addition to enabling the 
Maxtor OneTouch feature, you can:

• Automatically make copies of your most important files.

• Make copies of your data onto other popular storage devices, 
including CD-R, DVD-R, and selected tape drives.

• Recover lost work easily – restore a single file or the contents 
of an entire drive in one easy step.

• Save time and minimize storage space needs.

If you installed your drive with the Maxtor OneTouch feature, the 
Retrospect software is already installed. 

Retrospect User guide

For Windows: Use the built-in help system in Retrospect by 
clicking the question mark icon at the top of the screen in 
Retrospect.

For Macintosh: Use the Express User’s Guide in the Retrospect 
Express Folder on your Macintosh. If is not installed on your 
computer, you can access it on the Maxtor installation CD. 

Macintosh version of the Retrospect User’s Guide on the CD:
40

To learn more about creating a backup script, go to 
www.maxtorkb.com and enter “OneTouch” in the search function. 
Refer to the Express User’s Guide (on Macintosh) or the help 
system in Retrospect (on Windows) for detailed information about 
creating custom scripts and backup sets.

1. Insert the Maxtor Installation CD into your CD-ROM 
drive.

The Install CD icon will appear on your desktop.

2. Double-click the CD icon to open it.
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3. Open the folder appropriate for your language.

4. Drag the Express User’s Guide onto your Macintosh’s 
hard drive.

5. Double-click the Express User’s Guide to open it.

Note: You will need Adobe Acrobat Reader installed to open 
the guide. If you do not have it, you can download and install 
it for free from Adobe’s website: http://www.adobe.com

Restoring Files

It is easy to restore files that have been backed up using the Maxtor 
OneTouch feature. 

To restore files:

1. Select the drive containing the copy of your files.

2. Open the Retrospect Backup folder and then the folder 
that contains your backup copy.

Windows: The folder is named ‘Backup copy of Drive X,’ 
where X is the drive letter assigned by Windows.

Macintosh: The folder is named ‘Backup copy of 
your_disk_name’ (Only the first 9 characters of this 
name will be used).

3. Drag the file or group of files you wish to restore to the 
desired folder as you would to move or copy any other 
file.

page 70 in chapter 6 - Troubleshooting and FAQs, for an 
explanation of this problem and a suggested solution. 

Changing Your Maxtor OneTouch Script

Windows

1. Open Retrospect. 

2. Click Automate on the left side of the screen.

The Automate Overview window will appear.

3. Click Manage Scripts.

The Scripts window will appear.

4. Select the Maxtor OneTouch script. 

5. Press the Delete key on your keyboard.

A window appears asking: ‘Really delete script?’

6. Click OK.

7. Exit Retrospect, by going to the File menu and selecting 
Exit.

8. Push the button on the front of the drive.

The Maxtor OneTouch setup wizard will start and you 
can proceed as described in the “Setting Up the Maxtor 
Using Your Drive 41

If you are not sure where the files you want to restore are 
located, use your operating system’s Find or Search command 
to search the drive containing the backup data.

Retrospect backup files may be limited to 4GB. Refer to“My 
Retrospect® backup files seem to be limited to 4GB” on 

OneTouch Feature” in chapter 2.
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Macintosh

1. Open Retrospect Express. 

The Retrospect Express Directory window will open.

2. Click the Automate tab.

The Scripted Retrospect operations window 
will appear.

3. Click Scripts.

The Scripts window will appear.

4. Select the Maxtor OneTouch script. 

5. Press the Delete key on your keyboard.

A window appears asking: ‘Really forget Script?’

6. Click OK.

7. Quit Retrospect by going to the File menu and 
selecting Quit.

8. Push the button on the front of the drive.

The Maxtor OneTouch setup wizard will start. For OS X: 
See “To set up the Maxtor OneTouch button feature” on 
page 25 in chapter 2 and for OS 9: See

Adding Maxtor OneTouch Advanced Features

You can further customize your Maxtor OneTouch script with 
advanced features from Retrospect. To learn more about these 
advanced features, refer to the Retrospect User’s guide:

For Windows: Use the built-in help system in Retrospect by 
clicking the question mark icon at the top of the screen in 
Retrospect.

For Macintosh: Use the Express User’s Guide in the 
Retrospect Express Folder on your Macintosh. If is not 
installed on your computer, you can access it on the Maxtor 
installation CD. 

Using the Maxtor OneTouch Utility
Your Maxtor OneTouch drive includes a utility that allows you to:

• Find out more information about your drive 

• Customize your OneTouch button to launch a different 
application or file.

• Control power management settings for your drive.

Windows

Drive Information: 
42

“To set up the Maxtor OneTouch button feature” on 
page 32 in chapter 2. 1. Double-click the Maxtor OneTouch shortcut icon on 

your desktop to open it. 

The Maxtor OneTouch Settings window should 
appear.
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2. The Drive Information page will appear.

Here you can find out useful information, including:

• Model

• Serial Number

• Capacity

• Firmware version

Customizing your OneTouch button

Launching a different application or file:

You can launch most any application or file on your computer 
with the OneTouch button. For example, you could use it to 
launch an MP3 music program like Musicmatch Jukebox or 
even an individual playlist file.

1. Double-click the Maxtor OneTouch shortcut icon on 
your desktop to open it. 

The Maxtor OneTouch Settings window should 
appear.

The Drive Information tab should be selected.

current program that is assigned to open when you 
press the OneTouch button. 

It’s very simple to select a new program or file.

4. Click the Browse button and find the program or file that 
you would like to open. You’ll most likely need to 
navigate to your Program Files folder to do this. 

Note: If you want select a file, you’ll need to select ‘All 
Files’ or ‘(*.*)’ under the Files of type menu in the open 
window after you click the Browse button. If you don’t, 
only file names will not appear.

Once you’ve found your application or file, go to the 
next step.

5. Select your application or file and click Open.

6. Click Apply to save the change.

7. Now, try it out by pressing the button on your OneTouch 
drive.

The new application or file you selected in the OneTouch 
Settings program should open.

If your selected application does not function properly with 
the OneTouch button using the steps outlined above, it may 
Using Your Drive 43

2. Make sure that your OneTouch drive is selected. You 
should see it’s serial number and partition letter in this 
window.

3. Click the OneTouch Button tab at the top.

In the Application area of the screen, you can see the 

not be compatible or supported with the OneTouch feature. 
Double-check that you are selecting the correct file by 
opening it manually. If the application still does not open, 
contact the publisher of the application to find out if you are 
launching the correct file.
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How to reset the OneTouch button:

If you ever want to set your button back to launch your OneTouch 
script, it’s very easy.

1. Open the Maxtor OneTouch utility.

The Drive Information section will appear. If you have 
multiple Maxtor OneTouch drives, make sure you select the 
drive you wish to reset.

2. Click the OneTouch Button tab.

3. Click the Default button.

This sets the button back to it’s original settings

4. Click the Apply button.

This saves the settings.

5. Click the OK button to close the utility.

Macintosh
Drive Information: 

2. In the lower part of the window, you should see your 
OneTouch Drive listed and any other compatible Maxtor 
Drives currently connected and turned on.

Here you can find out useful information, including:

• Model

• Serial Number

• Application to be opened by the OneTouch button

Customizing your OneTouch button:

Launching a different application or file

You can launch most any application or file on your computer with the 
OneTouch button. For example, you could use it to launch a program 
like QuickTime or even a specific QuickTime file.

1. Go to your Applications folder on your Macintosh Hard 
Drive.

2. Double-click the Maxtor OneTouch Settings icon to open 
it. 

The Maxtor OneTouch Settings window should appear.

3. In the lower part of the screen you should see ‘Volumes,’ 
44

1. Open the Applications folder on your Macintosh hard drive 
and double-click the Maxtor OneTouch Settings icon to 
open it. 

The Maxtor OneTouch Settings window should appear.

‘Maxtor OneTouch Drives’ and ‘Open. . .’

Your Maxtor OneTouch drive should appear in this area. If 
you have multiple OneTouch drives you will be able to 
select each one separately. 

In the ‘Open...’ section of the screen, you should see the 
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Retrospect icon and the words: Maxtor OneTouch. This 
is what is currently set to open when you press the 
button on your OneTouch drive.

It’s very simple to select a different program or file.

4. Make sure your drive is selected in this window and click 
Select Action. 

A window will open where you can find and select the 
application or file on your system.

5. Find the application or file that you would like to open. 
You’ll most likely need to navigate to your Applications 
folder to do this. Once you’ve found it, go to the next 
step.

6. Select your application or file and click Open.

7. Close the Maxtor OneTouch Settings utility.

8. Now, try out your new settings by pressing the button 
on your OneTouch drive.

The new application or file that you selected 
should open.

If your selected application does not function properly with 
the OneTouch button using the steps outlined above, it may 

How to reset the OneTouch button:

If you ever want to set your button back to launch your 
OneTouch script, it’s very easy.

1. Open the Maxtor OneTouch Settings utility.

Once it opens, you should see your drive listed in the 
lower part of this window. 

2. Make sure your OneTouch drive is selected.

3. Click the Default Settings button.

This sets the button back to it’s original settings

4. Close the Maxtor OneTouch Settings utility.

Using Power Management

To minimize the power consumption of your drive while your 
computer is on, you can take advantage of the power management 
feature supported the Maxtor OneTouch Utility for Windows and 
the Energy Saver control panel for Macintosh.

The power management feature sets the drive to automatically use 
less power after a predetermined period of time of inactivity. This is 
sometimes referred to as spin down since the drive’s internal 
mechanical disks stop spinning. When the drive is in the spin down 
mode, one of the blue power lights will remain on and the other 
Using Your Drive 45

not be compatible or supported with the OneTouch feature. 
Double-check that you are selecting the correct file by 
opening it manually. If the application still does not open, 
contact the publisher of the application to find out if you are 
launching the correct file.

This file should open every time you push the button on your 
OneTouch drive. 

one will blink.

Power Management Settings: Windows

1. Open the Maxtor OneTouch utility on your desktop.

The Maxtor OneTouch Settings window will appear.
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2. Click the Power Management tab.

This page allows you to set the time period of inactivity 
before the drive will go to sleep. It is possible to choose 
as short as 3 minutes or as long as 5 hours. You can also 
set it to never go to sleep.

These settings are stored in the drive, so if you plug your 
drive into a different computer, the settings will not 
change.

3. Select a time period using the drop-down menu in the 
middle of the window.

4. Click the Apply button.

5. Click the OK button to close the OneTouch Utility.

Power Management Settings: Macintosh

OS 9

1. Under the Apple menu, select Control Panels.

The Control Panels folder will open.

2. Find and open the Energy Saver control panel.

The Energy Saver window will open, and the 

go to sleep. It is possible to choose as short as 10 
minutes and as long as 60 minutes. You can also set it to 
never go to sleep.

4. Select a time period using the slider in the bottom of the 
window.

5. Close the Energy Saver control panel.

OS X

1. Under the Apple menu, select System Preferences.

The System Preferences window will open.

2. Click the Energy Saver icon (a light bulb).

The Energy Saver panel will open, and the Sleep 
settings should be displayed.

3. Make sure the checkbox for ‘Put the hard disk to sleep 
when possible’ is checked.

The top setting, ‘Put the computer to sleep when it is 
inactive for,’ controls the time period of inactivity before 
the computer and it’s hard drives will go to sleep. It is 
possible to choose as short as 1 minute and as long as 
60 minutes. You can also set it to never go to sleep.

4. Select a time period using the top slider in the window.
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Sleep Setup settings should be displayed.

3. Make sure the checkbox for ‘Separate Timing for hard 
disk sleep’ is checked.

The slider at the bottom of the screen controls the time 
period of inactivity before the all system hard drives will 

5. Close the Energy Saver control panel.

Installing Applications on Your Drive
You may install and run applications from your OneTouch drive like 
any other drive on your system. 
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If you connect the drive to your system using a USB 1.1 interface, 
the data transfer rate is approximately 1 MB per second. Because 
of this, installing applications on a drive using the USB 1.1 
interface is not recommended. However, you can store the data 
for many applications and then access the data over a USB 1.1 
interface.

Most Windows-based and some Macintosh-based 
applications installed on your drive will only run on the 
computer where the application was installed. If you move 
your drive to any other computer, the application may no 
longer function. Once the drive is reconnected to the 
computer where the application was originally installed, the 
application will function properly.

Important Note for Windows 98SE and Me:
The Windows operating system expects applications to 
remain at the same drive letter location at all times. When 
your drive is removed from the system and plugged back in 
at a later time, Windows 98SE and Me operating systems 
may assign the drive a different drive letter. This can happen 
when another storage device is added to or removed from 
your computer while the drive is not connected to your 
system. If Windows has assigned a different letter to your 
drive than it had previously, any applications installed on the 
drive may no longer operate properly.

Editing Video

Windows

The FAT32 file system, that was installed on your OneTouch 
drive at the factory, limits any single file, including a digital 
video file, to a maximum size of 4 GB. Specify an existing 
folder or create a new folder on your drive. If you are running 
the Windows 98 or Me operating system, you should 
consider upgrading to Windows 2000 or XP to take 
advantage of the NTFS file system’s larger allowable file size 
and many other features.

If you are running either the Windows 2000 or XP operating 
system with a video editing application, you should consider 
re-formatting your drive to the NTFS file system. 
See “Formatting Your Drive for Windows” on page 34 in 
chapter 2 for instructions.

Reformatting the drive will destroy any data stored on
that drive. 

Moving Data Between Two Systems
Your Maxtor OneTouch drive provides a great tool for moving large 
amounts of data between two systems. For more information see 
the Maxtor online knowledgebase: http://www.maxtorkb.com

Playing Games
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Using a computer to capture and edit video recorded with a digital 
camcorder is quickly becoming popular. Digital video files are 
typically very large, using about 13 GB per hour of video content. 
Maxtor recommends connecting your drive using the FireWire 
interface for best results when working with video.

CD-ROM-based games typically run faster when they are installed 
on a hard drive rather than running them from the CD. You can use 
your OneTouch drive to store and play CD-ROM games. See See 
“Customizing your OneTouch button:” on page 44 for more 
information.
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To install a CD-ROM game

1. Start the install program on your game CD.

2. Select Maximum Install (if supported), if you are asked 
how to install the game on your system.

This option installs most or all of the game’s software onto 
your drive. 

3. When asked for the location to install the software, 
specify an existing folder or create a new folder on
your drive.

Due to limited transfer rates of USB 1.1, Maxtor does not 
recommend running games from drives connected through 
USB 1.1.

Storing Audio 
Using your computer as an audio jukebox is a very popular 
application. This allows you to store and play thousands of your 
favorite songs. You can also create and manage an audio library on 
your OneTouch drive. A popular web site to learn more about these 
audio applications is at http://www.mp3.com. 

To use your drive to store your audio library, you need to specify a 
folder on the drive as the default location for audio files in your 
audio jukebox software.

Adding Rubber Feet to Your 
OneTouch Drive
If you plan to use your drive on a desk surface, your kit includes 
four rubber feet to protect your drive and the surface of your desk.

To apply the feet:

1. Make sure your drive is disconnected properly from your 
computer. (See “Connecting and Disconnecting the 
Drive” on page 37).

2. Make sure your drive is turned off, by turning off the 
power switch on the back of the drive.

3. Turn your drive so that the ridges are facing up. This is 
the bottom of the drive.

4. Place two rubber feet on each ridge on the bottom of 
your drive. One should be placed near the front and the 
other toward the back of each ridge.

Rubber Feet 
Placement

Bottom of Drive
48



3

Using Large Capacity Drives with Windows 

When using Windows with drives that have capacities higher than 64 
GB, there are special considerations. Table 2 gives some information 

about how the Windows file systems and certain Microsoft utilities 
behave when used on drives with capacities greater than 64 GB.

Note 1: On disks larger than 64 GB running Windows 98SE, both FDISK Note 2: FDISK may not run properly after an external drive has been 

Table 2: Considerations for drive capacities greater than 64 GB

Windows 98SE Windows Me Windows 2000, XP

 FAT32 and 
NTFS 

FAT32 operates properly with 
partition < 127 GB.

FAT32 partitions operate properly 
as large as the drive’s 
total capacity.

FAT32 and NTFS partitions operate properly as large as the drive’s total 
capacity.

FDISK and 
FORMAT

Two known bugs,
see Notes 1 and 2.

One known bug,
see Note 1. 

NTFS partitions as large as the drive’s total capacity can be formatted 
properly under Windows 2000 and XP. 

FAT 32 partitions greater than 32GB cannot be formatted under Windows 
2000/XP. See Note 4.

Defrag and 
ScanDisk

Limited to partitions 
< 127 GB. See Note 3.

Defrag works properly on a disk of 
any size. Do not use Scan Disk.

Defrag works properly on a disk of any size.Do not use Scan Disk. 
See Check Disk.

Check Disk See Defrag and ScanDisk. See Defrag and ScanDisk. Operates properly. Note: May take a long time!

Disk 
Management

N/A N/A
Disk Management can create NTFS partitions as large as the drive’s total 
capacity.  Disk Management cannot create FAT32 partitions > 32GB. See 
Note 4.
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and FORMAT function properly, but will display an incorrect disk size on 
the screen. A similar problem can occur with Windows Me at larger disk 
sizes (starting above 80 GB).

Further information is available on Microsoft’s Web site at 
http://support.microsoft.com. Search their Support Knowledge Base for 
articles Q263044 and Q263045.

disconnected and reconnected. Rebooting the computer before running 
FDISK is recommended.

Note 3: Neither ScanDisk nor Defrag will operate on drive partitions larger 
than 127 GB. Further information is available on Microsoft’s Web site at http:/
/support.microsoft.com. Search their Support Knowledge Base for article 
Q184006. Third party utilities can be used to replace the functionality of the 
ScanDisk and Defrag utilities.
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Note 4: Windows 2000 and XP are limited to creating FAT32 
partitions < 32GB, you can format FAT32 partitions > 32GB using 
3rd party partitioning software. Windows 2000 and XP can mount 
FAT32 volumes larger than 32 GB that were created by other 
versions of Windows or 3rd party disk utilities.

Using Security Lock
Your new drive includes a security locking slot on the back of the 
drive. The security locking slot is compatible with most security 
locking cables, including those offered by Kensington.
50
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Backing Up Your System

One valuable use of your new Maxtor OneTouch drive is to backup 
your complete system. By using Retrospect, you can backup 
everything and restore your complete system, if you ever need to.2

What’s contained in a full system backup?

• Your current operating system.

• Your applications.

• Your personal files.

• Your computer’s settings

In the following section, you’ll learn how to create a script to back 
up your complete system and you’ll do your first backup. A script is 
simply a set of instructions that will tells Retrospect what files you 
want to copy, where you want to put them and when you’d like the 
copying to take place. In Chapter 6, we show you how to restore all 
the files on your system in the event that your system is damaged 
or completely erased.2___________

operating system, this product will only support the restoration of 
user files and does not support under those circumstances 
restoration of the Operating System, drivers, applications or settings.

Before you begin. . .
In order for your system backup to be successful, you need to know 
how big your complete system is and if your backup drive has 
enough capacity to store all your files. 

In the following steps, you will determine how big each drive on 
your system is. This is important information to have to not only to 
back up your system, but also in case you ever need to restore your 
system. We encourage you to write down this information and 
keep it in a safe place, just in case.

To determine how big your system is:

Windows: See below.
Macintosh: See next page.

4
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2      The Maxtor OneTouch drive, in combination with the included Dantz 
Retrospect software, supports a complete system restore capability 
(Operating System, drivers, applications, settings and user files) back 
to the original computer system (running the same operating 
system) that the backup copy was made from, when performed 
according to the steps described in this chapter.
If you need to restore data to a different computer and / or a different

Windows System Information

1. Open your My Computer icon.

When this window opens, you will be able to see each of the 
drives in your system.
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2. Go to the View menu and select Details.

You should now be able to see the Total Size (or capacity) of 
each drive. Write down the Total Size number for each drive on 
your system and keep the information in s a safe place. 

Figure 1.  Drive information: Windows

3. Add up the Total Size numbers for each drive.

This is how much total space is needed to backup your complete 
system if it were full.

4. Use this number as a guide to figure out how much space you
will need on your backup drive to store your complete system.

1. Starting from the desktop, you should be able to see each 
drive’s icon.

You will view information on each drive individually and then 
add them up.

2. Select a drive’s icon.

3. In OS X: Go to the File menu and select Get Info (OS X 10.2) or 
Show Info (OS X 10.1).
In OS 9: Go to the File menu and select Get Info,

then Information.

4. The Info window will open.

In this window you will be able to see the Capacity of the
drive, as well as the amount of space Used on the drive. Make
note of the Capacity number and close the window.

5. Repeat steps 1 - 4 for each drive on your Macintosh.

6. Add up the Capacity numbers for all of your drives.

This is how much total space is needed to backup your complete 
system if it were full.
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Macintosh System Information
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7. Use this number as a guide to figure out how much space you 
will need on your backup drive to store your complete system.

Figure 2.  Drive information: Macintosh

Backing up your complete system

Windows: See below.
Macintosh: See page 55.

Windows

1. Go to the Start menu and select Programs, then Retrospect, 
and then Retrospect 6.

Retrospect will open and the main window should appear.

2. Click Automate at the left side of the screen.

The Automate Overview window should appear.

3. Click EasyScript.

The EasyScript Wizard screen should appear.

4. Click Next. 

The next screen will ask you: ‘What type of media do you want 
to back up to?.’

5. Select Disks and click Next. 

The next screen asks you: ‘How many Backup Sets do you 
want?’
Backing Up Your System 53

6. Select I want one Backup Set for everything and click Next.

The next screen asks you: ‘How often do you want to back up?’

7. Select Every Weekday or Once a week and click Next.
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In the next screen you are asked: ‘When do you want your 
backups to start’

8. Choose the Start time. 

If you chose the Once a week backup option, choose the Day 
also.

9. Click the Next button.

The Backup Summary window will appear.

This window reminds you to make sure that the drive you plan 
to backup to (your Maxtor OneTouch drive) is connected to your 
system and ready.

You are given the option of doing your first backup immediately. 
It’s good idea to do this to test your script and make sure that it 
works.

Make sure Start the first backup now is checked at the 
bottom of the window.

10. Click Finish. 

Retrospect will scan your system and start the backup process.

After it finishes scanning, a window will appear asking you to:
‘Select a disk to add as storage . .’

12. Click OK. 

The EasyScript Backup window will open and Retrospect will 
start copying files to your OneTouch drive.

Normal backup may take a long time the first time. Each 
time after that, it will take less time. This is because 
Retrospect compares the files in your actual system to 
the backup version and only copies new files or files that 
have been modified since the last backup. For more 
information on backup strategies, see the Retrospect 
online help system, by clicking question mark icon in the 
Retrospect application.

When the backup finishes, you should see the message: 
‘Execution completed successfully.’

If your system backup was successful, you can exit Retrospect.

13. Under the File menu, choose Exit. 

When you exit Retrospect, a window may appear telling you 
script is’next for automatic execution.’

Make sure that the drive you plan to use for the next backup 
(your OneTouch drive) is connected to your computer and 
ready. If you are not sure, you can click the Check Media 
button to have Retrospect check for you. 
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11. Select your Maxtor OneTouch drive and click Proceed.

The Add New Member window will appear, reminding you of 
the drive you have chosen to backup your system to. 

Note: If you get the message that ‘the configuration isn’t 
ready,’ click Don’t Quit, make sure that your OneTouch drive 
is connected and turned on and quit Retrospect again. 

Congratulations. You’ve created an automated backup script and 
have done your first system backup. 
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Future backups will happen automatically at the time you specified 
in your script. All you have to do is leave your computer and Maxtor 
OneTouch drive on. You don’t even have to open Retrospect!

Making changes to your backup script

If you decide you want to change your automated backup, follow 
these steps:

To change the time of your backup:

1. Open Retrospect.

2. Click Automate on the left side of the screen.

The Automate Overview window will appear.

3. Click Manage Scripts.

The Scripts window will appear.

4. Select your script. It will be labelled EasyScript Backup.

5. Click Edit.

The EasyScript Backup window will appear, showing the details 
of your backup script. 

Note: In this window you can modify many aspects of your 

7. Close the EasyScript Backup window.

A message will appear asking: ‘Save changes to script?’

8. Click Save.

Your modified script has been saved and will run at the next 
scheduled time.

9. Exit Retrospect by going to the File menu and choosing Exit.

When you exit Retrospect, a window may appear telling you your 
script is ‘next for automatic execution.’

If you get the message that ‘the configuration isn’t ready,’ 
click Don’t Quit, make sure that your OneTouch drive is 
connected and turned on and quit Retrospect again. If this 
still doesn’t work, try creating a new EasyScript, following 
the steps outlined in the previous section.

10. Click Quit.

Your modified script has been saved and will run at the next 
scheduled time as long as your computer is on and your Maxtor 
OneTouch drive is connected and turned on.

Backing up your complete system
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backup, including which drives you will back up and the backup 
destination. For more information, see the Retrospect Express 
manual that came with your Maxtor drive.

6. Make any changes to your script needed.

Macintosh

You cannot run Retrospect Express under OS 9 to create 
system backups of OS X. You must run Retrospect Express 
under OS X to back up an OS X system.
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1. Open Retrospect Express

The Retrospect Express Directory window will open.

2. Click the Automate tab.

The Scripted Retrospect operations section will appear.

3. Click EasyScript. 

The ‘Welcome to EasyScript’ window will appear.

4. Click Next.

The Backup media page will appear.

5. Select File backup set (hard disk) and click Next.

The Backup frequency page appears asking you:
‘How often do you want to back up?’

6. Choose either Every day or Once a week

If you chose the once a week backup option, choose the 
Day also.

7. Click Next.

The EasyScript backup strategy window appears.

10. Type in a memorable name, like System Backup, and click New. 

The Choose a Folder window will now appear.

11. Select the drive you plan to back up to (your Maxtor OneTouch 
drive) and click Save. 

A window will appear telling you: ‘EasyScript has created and 
scheduled a script’

At this point, you can click Open Script to view your script and 
make changes, or you can simply click Done to finish. You’ll 
learn how to make basic changes to your script later in this 
chapter.

12. Click Done.

You now have a finished script that will automatically backup your 
system at the time and date you specified. All you have to do is 
leave your computer and Maxtor OneTouch drive on. You don’t even 
have to open Retrospect Express!

We highly recommend that you run your backup script manually the 
first time to make sure that it backs up everything you need. You’ll 
learn how to do this in the following section.

Doing your first backup: testing your script
56

8. Choose a start time for your backups.

9. Click Create.

A window appears asking you: ‘What do you want to name 
your backup set?’

1. Open Retrospect Express (if not already open).

The Retrospect Express Directory window will open.

2. Click on the Run drop-down menu at the top of the screen and 
pull down to select EasyScript Backup. 

The EasyScript Backup window will appear.
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3. Make sure Execute now is selected and click Execute. 

Retrospect will now start scanning your system, the 
Immediate Backup window will open and the backup process 
will begin. 

Normal backup may take a long time the first time. Each 
time after that, it will take less time. This is because 
Retrospect compares the files in your actual system to the 
backup version and only copies new files or files that have 
been modified since the last backup. For more information 
on backup strategies, see the Retrospect online help 
system, by clicking question mark icon in the Retrospect 
Express application.

When the backup is complete, the message: ‘Execution completed 
successfully’ should appear.

If your system backup was successful, you can quit Retrospect.

4. Go to the File menu and select Quit.

When you quit Retrospect, a window will appear telling you: 
‘Script EasyScript Backup is next for automatic execution.’

This is a reminder to make sure that the drive you plan to use for 
the next backup (your OneTouch drive) is connected to your 
computer and ready. If you are not sure, you can click the Check 

Congratulations, You’ve now done your first system backup!

See “Disaster Recovery” on page 59 in chapter 5,” for guidelines 
on how to restore your system using the system backup you just 
created, in the event that you need to.

Making changes to your backup script

If you decide you want to change your backup script, follow 
these steps:

To change the time of your backup:

1. Open Retrospect Express.

The Retrospect Express Directory window will appear.

2. Click the Automate tab.

The Scripted Retrospect operations section will appear.

3. Click Scripts.

The Scripts window will appear.

4. Select your script. It will be labelled EasyScript Backup.
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Media button to have Retrospect check for you. 

If you get the message that ‘the configuration isn’t ready,’ 
click Don’t Quit, make sure that your OneTouch drive is 
connected and turned on and quit Retrospect again. 

5. Click Quit.

5. Click Edit.

The EasyScript Backup window will appear, showing the details 
of your backup script. 
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In this window you can modify many aspects of your 
backup, including which drives you will back up and the 
backup destination. For more information, see the 
Retrospect Express manual that came with your 
Maxtor drive.

6. Make any changes to your script needed.

7. Close the EasyScript Backup window.

A message will appear asking: ‘Save changes to script?’

8. Click Save.

9. If the Scripts window is still open, close it.

10. Quit Retrospect by going to the File menu and choosing Quit.

When you quit Retrospect, a window will appear telling you: 
‘Script EasyScript Backup is next for automatic execution.’

If you get the message that ‘the configuration isn’t ready,’ 
click Don’t Quit, make sure that your OneTouch drive is 
connected and turned on and quit Retrospect again. If this 
still doesn’t work, try creating a new EasyScript.

Your modified script has been saved and will run at the next 
scheduled time as long as your computer is on and your Maxtor 
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OneTouch drive is connected and turned on.
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Disaster Recovery

If disaster has struck and your system software is damaged or 
completely erased, this chapter provides you with step-by-step 
instructions on how to restore your system.3

These steps will be successful ONLY if you have backed up your 
system using Retropsect and the steps outlined in the previous 
chapter. 

What’s contained in a full system restore?

• Your current operating system

• Your applications

• Your personal files

• Your computer’s settings - including the Registry (on Windows)

Before you begin. . .
Because of factors like processor type, motherboard, video display 

3     The OneTouch drive, in combination with the included Dantz 
Retrospect software, supports a complete system restore capability 
(Operating System, drivers, applications, settings and user files) back 
to the original computer system (running the same operating 
system) that the backup copy was made from, when performed 
according to the steps described in this chapter. If you need to 
restore data to a different computer and / or a different operating 
system, this product will only support the restoration of user files 
and does not support under those circumstances restoration of the 
Operating System, drivers, applications or settings.

Basic Guidelines

For your system restore to be successful, we recommend that
you restore your system only: 

• To the same computer and same internal drive

• To the same computer and new internal drive

If you cannot restore to your original computer or an identical 
system, you can restore all of your personal files to a different 
computer. For more information see http://www.maxtorkb.com.

5
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card and other hardware that is specific to your brand and model of 
computer, we urge you to ONLY do a full system restore to the 
same computer. Restoring your operating system, its applications 
and settings to another computer with different hardware is not 
supported and may cause significant problems with that computer.

_________________________________________
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Restoring your complete system

Windows 2000, XP, 98SE, ME

Before you begin to restore your system backup, you must install 
the same version of the operating system that you were using 
originally, and create the same number of disk partitions (drive 
letters). These partitions must be of equal or greater size to what 
they were on your original system. For information on how to 
partition and format your system drive, see the Maxtor 
Knowledgebase online at: http://www.maxtorkb.com.

NOTE: Do not partition or reformat the Maxtor OneTouch drive that 
your system backup is stored on.

Once your system is running with the same operating system and 
disk partitions, reinstall Retrospect using the Maxtor Install CD. 
See “Installing Your Drive” on page 6 in chapter 2.

NOTE: If you are running Windows ME, you’ll need to do take 
these additional steps before you restore your system:

• Go to the Retrospect Express application directory (typically: in 
Program Files/Dantz/Retrospect on your C drive)

• Open the folder named ‘drsupp’

• Open the file named ‘mersthlp’

Restoring your system - Step-by-step

1. Prepare your hard dive - (Partition, if necessary, and format.)

2. Install your operating system. 

3. Reinstall Maxtor OneTouch software including Retrospect.
(For more information see page 6 in chapter 4.)

4. Open Retrospect.

5. Click Tools on the left side of the screen.

The Tools Overview window will open.

6. Click Repair Catalog. 

A window will appear asking you to ‘Select a Catalog Repair 
Function’ 

7. Select Recreate from disks and click OK.

A window will appear asking you ‘Which disk do you want 
Retrospect to check for Backup Set data files?’

8. Click All disks.

A window will appear asking you to ‘Select a disk where the 
Backup Set data is stored.’

9. Select the disk where you backed up your system (your Maxtor 
60

• Click OK when prompted to disable PC Health/File System 
Protection

• Click OK when prompted to restart your computer

OneTouch drive). 

10. Click OK.

A window will appear asking you to ‘Select a Backup Set to 
recatalog.’
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11. Select your most recent backup set and click OK.

A window will appear asking you: ‘Are there any more disks in 
the Backup set?’

12. Click the No button.

The next window appears where you can save your catalog file.

The file will automatically be placed in Retrospect Catalog Files 
folder inside your My Documents folder on your hard drive. If 
you’d prefer, you can specify a new location. 

13. Click Save. 

The Recatalog window will now appear.

14. Click Build Catalog File.

A window will appear asking you: ‘Are there any other 
members in this Backup Set?’

15. Click No. 

Retrospect will now build the new catalog file and the 
message: ‘Execution completed successfully’ should appear.

16. Click Close.

A window will appear, asking you to select the ‘Source 
Snapshot for restore.’ 

19. Select your Backup Set at the top of the window. 

Select your C:Drive at the bottom of the window 

20. Click OK. 

The next window will ask you to specify a ‘Destination for 
the restore.’ 

21. Select the drive that you want to restore and make sure that 
‘Restore Entire Volume’ is selected in the drop-down menu.

22. Click OK. 

A window appears asking if you really want to restore.

23. Click Replace. 

The system restore will now begin.

This may take several minutes. 

When it finishes, you should see the message: ‘Execution 
completed successfully.’

24. Exit Retrsopect by going to the File menu and choosing Exit.
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Now, it’s time to restore your system.

17. Click Restore on the left side of the screen.

The Restore Overview window will appear.

18. Click Entire Volume.

25. Restart your computer.

Your system may require more than one restart. Follow any 
additional onscreen instructions, if necessary, to complete 
your system restore.
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If the system restore was successful, you should find all of the files 
that you originally backed up. If not, make sure that you understand 
how to back up your system using the steps outlined in Chapter 4: 
‘Backing up your system.’ By scheduling automated backups, 
you’re less likely to lose your valuable files in the future.

Restoring your complete system

Macintosh OS X and 9

Before you begin, you must format your system hard drive and 
install your operating system. If you had multiple partitions on your 
hard drive(s), you must create and format the same number of disk 
partitions. These partitions must be of equal or greater size to what 
they were on your original system. For information on how to 
partition and format your system drive, see the Maxtor 
Knowledgebase online at: http://www.maxtorkb.com.

NOTE: Most Macintosh computers are setup at the factory with 
only one partition per hard drive. If you did not have multiple 
partitions on any of your hard drives, all you have to do is reformat 
your hard disk(s) and re-install your Macintosh operating system. 
For more information, see your Macintosh manual.

NOTE: Do not partition or reformat the Maxtor OneTouch drive that 
your system backup is stored on.

Once you get your system running, reinstall Retrospect Express 
using the Maxtor Install CD. See “Installing Your Drive” on page 6 
in chapter 2. 

Restoring your system - Step-by-step

1. Prepare your hard dive - (Partition, if necessary, and format.)
62

2. Install your operating system. 

3. Reinstall Maxtor OneTouch software including Retrospect 
Express. (For more information see page 6 in chapter 4.)
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4. Open Retrospect Express.

The Retrospect Express Directory window will open.

5. Click Restore. 

A window will appear asking you to ‘Select the restore type’ 

6. Select Restore an entire disk and click OK.

The ‘Accessing more backup sets’ window will appear asking 
you to open an existing catalog file or rebuild one.

7. Click Open.

Find and select the system backup set on your Maxtor 
OneTouch Drive.

8. Click Open. 

Your system backup set should appear in the top part of the 
Restore from Backup:Source window. Make sure it 
is selected.

9. Click OK.

The Destination Selection window will now appear, asking 
you to choose a ‘Destination for restore.’

A window will appear asking you if you really want to restore to 
the drive you selected, replacing it’s entire contents.

11. Click Replace.

Retrospect will scan your system (This may take a 
few minutes).

The Restore from Backup window will appear, allowing you to 
confirm the source (your OneTouch drive) and the destination 
(your Macintosh hard drive) for the restore.

12. Click Restore.

A window will appear asking you: ‘Really Execute?’

13. Click OK.

(If the ‘Really Execute?’ window appears again, click OK.)

Retrospect will begin to restore your system.

This process may take several minutes.

When Retrospect finishes, you should see the message: 
‘Execution completed successfully.’

You can view the Log to make sure that all of your files were 
Disaster Recovery 63

Make sure Restore Entire Disk is selected. and select the 
drive that you want to restore your system to (your Macintosh 
hard drive where the system was originally installed).

10. Click OK.

restored by going to the Window menu and selecting Log.

14. Quit Retrospect, by going to the File menu and selecting Quit. 

15. Restart your Macintosh.

If the system restore was successful, you should find all of the files 
that you originally backed up. If not, make sure that you understand 
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how to back up your system. See “Backing Up Your System” on 
page 51 in chapter 4. By scheduling automated backups, you’re 
less likely to lose your valuable files in the future.
64
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Troubleshooting and FAQs

This chapter provides troubleshooting tips and answers frequently 
asked questions about installing your Maxtor OneTouch drive.

You can find additional information in the Maxtor Knowledge Base 
at www.maxtorkb.com or contact Maxtor at www.maxtor.com.

Chapter Contents

General Troubleshooting
1. Drive does not appear on my system 66
2. My drive appears to read files significantly faster than it writes files 67
3. My drive shows less capacity than on the box label 68
4. Maxtor OneTouch function does not work 68
5. My drive is not copying or backing up a network drive 69
6. My Macintosh reports the drive is “unreadable” (Mac OS 9) 69
7. What does partitioning a drive mean? 70
8. How do I partition a drive? 70

USB Troubleshooting
9. My applications run slowly using the USB 1.1 interface 70
10. I get a message stating that I have a high-speed device 70

connected to a low-speed port (Windows XP)
11. I’m having data transfer performance problems with my 70

USB 2.0 adapter card

Application Troubleshooting
12. Applications installed on the drive stopped running 70
13. My Retrospect backup files seem to be limited to 4GB 70
14. My computer drops frames when I capture video from my 70

6
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Canon camcorder
15. Administrator Privilege for Windows 71
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General Troubleshooting

1. Drive does not appear on my system

• Is the drive running?

The two blue lights on the front of the drive should be 
illuminated, and you should be able to feel the hum of the drive 
when you place your hand on it. In addition, the light on the 
power adapter should be lit.

Make sure the power adaptor is securely plugged into the drive 
and into a power outlet. If the drive is plugged into a power 
strip, try plugging it directly into the wall outlet, in case the 
power strip is not working properly.

• Are the FireWire/USB cables connected properly?

Verify that the cables are connected according to the installation 
instructions of “Installing Your Drive” on page 6 of chapter 2.

• Have you tried cycling the power for the drive?

a. While your computer is running, unplug the FireWire/USB 
cable from the drive, then turn off the drive.

b. Wait ten seconds, turn the drive back on.

c. Wait another ten seconds, plug the FireWire/USB cable in. 
See if the drive appears on your system.

If the drive does not appear on your system, try the tips in the next 

Tips for Windows Only

• Have you installed the 1394 Storage Supplement for 
Windows 98SE? 

If not, refer to “Windows 98SE Only:” on page 16 for 
details.

• Is your FireWire or USB interface card recognized 
and working properly in the Device Manager?

To open the Device Manager:

a. Select Start Î Settings Î Control Panel.

b. Double-click the System icon. The System Properties 
dialog box appears. 

• 98SE and Me: Select the Device Manager tab.

• 2000 or XP: Select the Hardware tab and then click
 Device Manager.

c. Double-click the entry for 1394 Bus Controller or 
Universal Serial Bus Controller (which ever interface 
you're using). Also for FireWire / 1394: an entry appears 
with a name that contains the words OHCI compliant 
IEEE 1394.

If you see a yellow ‘!’ exclamation point next to the entry, 
the interface card is not installed properly. Consult the 
66

section for your computer’s specific operating system. If the drive 
still does not appear on your system, visit the Product Support area 
of the Maxtor web site at www.maxtorkb.com for 
further assistance.

documentation that came with the card or contact the 
card’s manufacturer.
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Tips for Macintosh Only

Do you have the most current Maxtor software?

Check the Product Support area at: 
www.maxtorsupport.com to determine the latest version.

Are AppleTalk and File Sharing off? If not, turn them off 
and reboot. If, after rebooting, the drive still does not 
mount, try turning the drive off and back on again. 

Follow these steps to open the Apple System Profiler.

For OS X or later:

• Go to the Apple Menu and select About This Mac.

The About this Mac screen will appear.

• Click the More Info button. The Apple System 
Profiler will open. 

• Click the Devices and Volumes tab.

• Depending on which Maxtor hard drive you are 
using, your Maxtor drive should appear as a
rectangle in either the USB or FireWire Information 
sections of the screen. 

• Clicking any of the horizontal triangles next to the 
different rectangles on this screen, shows more 

For OS 9:

• Go to the Apple Menu and select Apple System 
Profiler. The Apple System Profiler will open. 

• Click the More Info button. The Apple System 
Profiler will open. 

• Click the Devices and Volumes tab.

• Depending on which Maxtor hard drive you are 
using, your Maxtor drive should appear as a
rectangle in either the USB or FireWire sections 
of the screen. 

• Clicking any of the horizontal triangles next to the 
different rectangles on this screen, shows more 
detailed information about the device, including 
the manufacturer. 

• If you can’t find your Maxtor drive, try turning the 
drive off, waiting 10 seconds and turning it back on.

If your drive does not appear after trying all of the suggestions 
above, visit the Product Support area at: 
www.maxtorsupport.com.

2. My drive appears to read files significantly faster 
than it writes files

Your drive includes a special data protection function, which 
automatically verifies all data written to the drive during the first 
Troubleshooting and FAQs 67

detailed information about the device, including 
the manufacturer. 

If you can’t find your Maxtor drive, try turning the 
drive off, waiting 10 seconds and turning it back on.

few uses of the product. It’s similar to the break-in period for a 
new car. The verification process is performed while data is 
being written, causing reduced write performance. 
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This verification function is automatically turned off after your 
drive has been powered on and off ten times (you need to leave 
the drive running for 15 seconds before powering it off and leave it 
off for 15 seconds before powering on again). After this break-in 
period, you should see approximately the same performance for 
reading and writing data.

3. My drive shows less capacity than on the box label

Hard drive capacity is defined in terms of decimal (base 10) 
capacity. In decimal notation, one megabyte (MB) is equal to one 
million bytes and one gigabyte (GB) is equal to one billion bytes. 
We are most accustomed to the decimal system in everyday life. 
However, computers use the binary (base 2) numbering system. 
In the binary numbering system, one megabyte is equal to 
1,048,576 bytes, and one gigabyte is equal to 1,073,741,824 
bytes. 

Both Windows and Mac OS use the binary numbering system. 
When you use your system to check your drive’s capacity, multiply 
the value shown (displayed in base 2 megabytes) by 1,048,576 to 
determine the decimal equivalent for the hard drive's capacity.

Windows:

Here is an example using a 160 GB drive on a system|
running Windows (all versions):

• Right-click the My Computer icon and select Explore.    

This opens a new window listing all the disk drives on 
your system. 

Macintosh:

Here is how to access hard drive capacity on a Macintosh:

• Select the external hard drive.

• For OS X or later, choose File>Get Info. 

• For OS 9, choose File>Get Info>General Information

4. Maxtor OneTouch function does not work

Here are a few items you can quickly check if your Maxtor 
OneTouch feature does not operate.

The Maxtor OneTouch button may not function when Retrospect 
Express is already running. To correct the problem:

On Macintosh:

• From the File menu, select Quit. 

• Press the Maxtor OneTouch button again. Retrospect Express 
should open and your backup copy should begin

On Windows:

• From the File menu, select Exit. 

• Press the Maxtor OneTouch button again. Retrospect should 
open and your backup copy should begin.

The OneTouch backup copy will not run if the Retrospect software 
68

• Right-click on the external hard drive and select Properties. 

An information dialog box appears displaying the drive’s capacity 
in both numbering systems showing 152 GB and 
163,921,571,840 bytes (assuming this model is labeled 160 GB).

cannot locate either the source drive or the destination drive. To check 
this problem:

On Windows:

• Start the Retrospect program. 

• Click the Automate link on the left side of the screen.
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• Click the Manage Scripts button. 

• You should find a script called Maxtor OneTouch. This 
script defines what exactly will be backed up

If you do not see this file, follow the instructions in the “Setting 
Up the Maxtor OneTouch Feature” in chapter 2. 

• Select the Maxtor OneTouch entry and then click the Edit 
button.

Confirm that both the source and destination drives (volumes) 
are defined and are currently running on your system. 

On Macintosh:

• Start the Retrospect program. 

• Click the Automate tab at the top of the screen.

• Click the Scripts button. 

• You should find a script called Maxtor OneTouch. This 
script defines what exactly will be backed up

If you do not see this file, follow the instructions in the “Setting 
Up the Maxtor OneTouch Feature” in chapter 2.

• Select the Maxtor OneTouch entry and then click the Edit 
button.

Confirm that both the source and destination drives (volumes) 
are defined and are currently running on your system. 

Windows: If a new letter is assigned to either the source or the 
destination drives after you create the script, the backup will 
not work.

d. You can also click on the checkmark icon on this window to 
test the definition of the currently selected script.

The OneTouch feature is not supported for USB on the 
Macintosh.

5. My drive is not copying or backing up 
a network drive

Your Maxtor OneTouch drive and Retrospect Express software 
are not supported for the purpose of copying or making backup 
copies of network drives available from your computer. You 
may encounter Microsoft Windows errors (Windows Error 
Event ID: 9, 11, 15, 50 and 51). For further information, check 
the Maxtor Knowledge Base at: www.maxtorkb.com or look up 
“network drive” using the Windows Help feature.

6. My Macintosh reports the drive is “unreadable”

After connecting the Maxtor drive to a Macintosh computer, 
the following message may appear:

In OS 9: “This disk is unreadable by this computer. Do you 
want to initialize the disk?”

In OS X or later: “You have inserted a disk containing no 
Troubleshooting and FAQs 69

Macintosh: 

If you rename either the source or the 
destination drives after you create the script, the backup will 
not work.

volumes that OS X can read. To use the unreadable volumes 
click Initialize.”

In order to use this drive you will need to initialize (format) it.

To format your drive, follow the steps outlined in chapter 2:
“Macintosh OS X: Connecting the Drive” on page 21 of 
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chapter and “Macintosh OS 9: Connecting the Drive” on 
page 28 of chapter.

7. What does partitioning a drive mean?

Partitioning is a way of dividing up your hard drive into different 
sections which appear as separate drive letters in windows and 
drive icons in the Macintosh OS. Partitioning helps you to 
manage files more easily. One common use of partitioning is to 
install your operating system in one partition and all of your 
applications in another. 

8. How do I partition my drive?

There are a number of excellent programs for partitioning. For 
more information on the appropriate one for your operating 
system see the Maxtor online knowledgebase:
http://www.maxtorkb.com

USB Troubleshooting

9. My applications run slowly using the 
USB 1.1 interface

When you connect the drive to your system using the
USB 1.1 interface, the data transfer rate is approximately
1 MB per second. Maxtor does not recommend installing 
applications on a drive using the USB 1.1 interface. You can 
however use your drive to store the data for many applications 
over a USB 1.1 interface.

have the high-speed capabilities that you would have with a 
USB 2.0 port.

11. I’m having data transfer performance problems with 
my USB 2.0 adapter card

Maxtor drives will run as fast as the host adapter card will allow 
(up to the maximum burst rate of 480 Mb per second). If you 
are having performance issues, make sure the card’s drivers 
are the most current available and that they are installed 
properly.

Application Troubleshooting

12. Applications installed on the drive stopped running

See “Installing Applications on Your Drive” on page 46 of 
chapter 3, for an explanation of possible reasons for and 
solutions to this problem.

13. My Retrospect® backup files seem to be limited 
to 4GB

Backup files created by Retrospect Express may be limited to a 
file size of 4GB. This limitation is due to the file size restriction 
imposed by the FAT32 file system. You can remove this 
limitation for Windows 2000 / XP and the Macintosh by 
reformatting your drive to another file system. See “Formatting 
Your Drive for Windows” on page 34 in chapter 3 for additional 
information.
70

10. I get a message stating that I have a high-speed 
device connected to a low-speed port 
(Windows XP)

This is normal. Windows XP is letting you know that you have 
connected your USB 2.0 drive to a USB 1.1 port and you will not 

14. My computer drops frames when I capture video 
from my Canon camcorder

Some models of Canon camcorders produced in 1998 and 1999 
have trouble transferring DV data over the 1394 interface. For 
the latest information and a solution for this problem, search 
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the Maxtor Knowledge Base at www.maxtorkb.com with the 
key word “Canon.”

15. Administrator Privilege for Windows

During software installation, the Windows operating system 
may display a message regarding a requirement for 
Administrator Privilege to install and run the Retrospect 
software. To check if you have Administrator Privilege for the 
account you use to “Logon” into Windows, follow these steps:

a. Click the Windows Start button, choose Control Panel.

b. Double click the User Accounts icon.

c. If your account Logon is displayed at the bottom of this 
window with the description: Computer Administrator, you 
have the correct administrator privileges to install and run this 
software.

If your system shows another type of account status, contact 
your IS / Computer Manager for further assistance.
Troubleshooting and FAQs 71
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Glossary

Byte – A unit of storage on a drive that holds a single character. 
A byte is equal to 8 bits.

Capacity – The amount of information, measured in bytes, that 
can be stored on a drive. Also known as storage capacity.

Daisy chain – A hardware configuration in which peripheral 
devices are connected to each other in a series. The FireWire 
interface, for example, supports a daisy chain of up to 62 drives. 

Data Transfer Rate – The speed at which data transfers to 
and from the drive.

Defrag – (or defragment) A software utility that keeps the data 
for each file physically contiguous on the drive, which can 
enhance your drive’s performance.

Device Driver – A software program that enables a PC to 
communicate with peripheral devices such as hard drives and 
CD-ROM drives. Each type of device requires a different driver. 
Device driver programs are stored on a computer’s hard drive and 
are loaded into memory when the computer is started or when a 
device is plugged into the computer.

FAT32 – A file system that organizes files on the computer.
This file system is standard for Windows 98SE and Me, and is 
supported under Windows 2000 and XP. A single file is limited
in size to 4 GB.

FDISK – A software utility included with the Windows 98 and 
Me operating systems used to partition a hard drive.

FireWire – The FireWire interface, also known as 1394 and 
i.LINK, is a high-performance, serial bus defined by the Institute 
of Electrical and Electronics Engineers (IEEE) as a standard for 
connecting digital devices together. It is ideal for connecting 
computers and hard drives to digital video and audio equipment.

Format – Formatting erases all information on a hard drive and 
sets up the file system for storing and retrieving files. On 
Macintosh systems, high-level formatting is often referred to as 
initialization. Low-level formatting sets up the locations of sectors 
on the drive. Your drive was formatted with the FAT32 file system 
at the factory.

GB – (Gigabyte) Equal to 1,000,000,000 (billion) bytes. For a 
detailed explanation, refer to page 29.
Glossary 72

External Hard Drive – A external peripheral device containing 
a hard drive mechanism connected to a computer via a FireWire 
or USB interface.

Hard Drive – An electromechanical device used for information 
storage and retrieval, incorporating one or more rotating disks on 
which data is recorded, stored, and read magnetically. 
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Hot-Swap – This feature allows you to connect and disconnect 
external devices while the computer and the devices are running. 
External drives, such as the Maxtor Personal Storage 5000 can 
be hot-swapped.

KB – (Kilobyte) Equal to 1,000 (thousand) bytes.

MB – (Megabyte) Equal to 1,000,000 (million) bytes.

Mb – (Megabit) When used to describe data storage, equal to 
one million bits. 

Mbps – (Megabits per second) When used to described data 
transfer rates, it refers to one million bits per second.

NTFS – The primary file system for Windows 2000 and XP 
operating system that organizes files on your computer. Supports 
large capacity hard drives up to 2 TB.

Operating System – Software that allows the user and 
programs installed on your system to communicate with 
computer hardware such as a hard drive and processor.

Partition – A way to logically divide a hard drive so that an 
operating system treats each partition as if it were a separate 
hard drive. Each partition is assigned a unique drive letter in 
Windows or icon in the Mac OS.

Port – A connection or socket on the motherboard, controller 
card, case, or chassis for connecting peripheral devices, such as 
a USB socket or FireWire socket. 

ScanDisk – A utility for Windows 98SE and Me that finds and 
corrects errors in the file system on a hard drive.

Script – A saved backup procedure for Retrospect that you can 
schedule to run at some future date and time or on a repeating 
schedule, such as daily. You may create as many scripts as you 
wish.

Spin Down – Refers to the actually spinning of the disk 
mechanism. When a disk spins down, it stops spinning, thus 
conserving power.

Startup Disk – The drive from which the operating system 
loads to start up your computer.

TB – (Terabyte) Equal to 1,000,000,000,000 (trillion) bytes. 

USB – Universal Serial Bus, a standard for connecting external 
devices to your computer. 

Volume – A fixed amount of storage on a hard drive. The term 
volume is often used as a synonym for the drive itself, but it is 
possible for a single drive to contain more than one volume or for 
a volume to span more than one drive.
73
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